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1 Introduction

1.1 Overview

MQ Visual Edit (MQVE) application allows users to view, manipulate and manage messages in a 
queue and/or a topic of an IBM MQ (formally WebSphere MQ & MQSeries) queue manager and 
presents the data in a simplified format similar to a database utility or spreadsheet program.

MQ Visual Edit is a great tool for application programmers, JMS developers, quality assurance testers, 
and production support personnel. The tool allows for quick problem solving because the data is 
presented in a very logical and insightful manner.

MQ Visual Edit is designed to run on a desktop platform. This includes: Linux x86 64-bit, macOS 
(Mac OS X), Windows 7/8/8.1/10 and Raspberry Pi (ARM).  MQ Visual Edit is able to connect to 
local queue managers (residing on the same box) or to any remote queue manager.

The remote queue managers can be on any platform that supports distributed queuing including: AIX, 
HP-UX, HPE NonStop, Linux, IBM i (OS/400), Oracle Solaris, Raspberry Pi (ARM),  Tandem, 
Windows 2008/2012/2016 Server, Windows 7/8/8.1/10 and z/OS (OS/390).

MQ Visual Edit has full language support for the following 55 languages: Amharic, Arabic, 
Azerbaijani, Bengali, Cebuano, Chinese (Mandarin China), Chinese (Mandarin Taiwan), Czech, 
Danish, Dutch, English, Finnish, French, German, Greek, Gujarati, Hausa, Hebrew, Hindi, Hungarian, 
Igbo, Indonesian, Italian, Japanese, Javanese, Kannada, Korean, Malay, Malayalam, Marathi, 
Norwegian, Panjabi, Pashto, Persian, Polish, Portuguese, Romanian, Russian, Shona, Sindhi, Spanish, 
Sundanese, Swahili, Swedish, Tamil, Telugu, Thai, Turkish, Ukrainian, Urdu, Uzbek, Vietnamese, 
Xhosa, Yoruba and Zulu.

MQ Visual Edit supports both forms of MQ security: 

 SSL/TLS for connecting to remote queue managers.
 3rd party security exit for connecting to remote queue managers.
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1.2 Prerequisites
This section provides the minimum supported software levels.

1.2.1 Operating System
MQ Visual Edit is capable of running on the following operating system platforms:

 Windows 7/8/8.1/10
 Linux x86 64-bit (Desktop)
 macOS (Mac OS X) 10.8 or higher (client mode only)
 Raspberry Pi (ARM)
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2 Installing MQ Visual Edit
This chapter will describe the installation and registration of MQ Visual Edit.

2.1 Installation

2.1.1 Windows Installation

To install MQ Visual Edit on Windows, do the following instructions:

• Run the install program called: mqve3-setup-withjre.exe
• The installer follows the standard Windows install procedures and provides default values for 

the user.
• When the install program has completed execution, there will be a newly created folder under 

Start -> All Programs called MQ Visual Edit. 
• To run MQ Visual Edit, select the MQ Visual Edit icon from within the MQ Visual Edit folder.

2.1.2 Linux Installation

To install MQ Visual Edit on Linux x86 64-bit, do the following instructions:

• First, the user needs to set the 'execute' permission for the installer program:

chmod +x mqve3-setup-linux.bin

• Next, run the installer with the following command:

./mqve3-setup-linux.bin

• The installer will prompt the user for the installation directory.  The default value will be 
'Capitalware/MQVE3/'.

• To run MQ Visual Edit, go to the installation directory and issue the following command:

./mqve
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2.1.3 macOS Installation
To install MQ Visual Edit on macOS, do the following:

• Double click the MQ_Visual_Edit_V3.dmg file to open it
• Follow the instructions on the opened DMG window and drag the MQ Visual Edit icon to the 

Applications folder.
• Close the DMG window and then eject the DMG
• To run MQ Visual Edit, go to the Application folder and double click on MQ Visual Edit

2.1.4 Raspberry Pi Installation
To install MQ Visual Edit on Raspberry Pi, do the following:

1. ftp or copy the selected mqve-RaspberryPi.tar.zip file to the target platform
2. Unzip the mqve-RaspberryPi.tar.zip to an appropriate directory with the following commands:

unzip mqve-RaspberryPi.tar.zip
tar -xvf mqve-RaspberryPi.tar

3. Change directory to Capitalware/MQVE/
4. To run MQ Visual Edit, go to the installation directory and issue the following command:

./mqve
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2.2 Registration
This section will describe how to obtain a license and then register your copy of MQ Visual Edit.
To purchase a copy of MQ Visual Edit (obtain a license), go to Capitalware's web site 
(www.capitalware.com) and select MQ Visual Edit, then click the Buy Now button.

A license is for a single end-user.  Once the user has received their license key, they will need to input 
the license key in the Registration window and then retrieve an Access Code.  Note: A license key can
ONLY be registered once.  When the user clicks the Submit button MQ Visual Edit will attempt the 
register the user's license key by contacting the 'capitalware.com' server.

Note: Do not register MQ Visual Edit under Administrator 
account or any other SysAdmin account.  It must be the end-user 
who completes the registration process under their own account.

If your company uses a Proxy Server then the user will need to input this information, so that MQ 
Visual Edit can access the internet.  Select File then Preferences: 

Click Enable Proxy Server checkbox then input your company's Proxy Server and Proxy Port and 
click OK to save the information.
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To input the license key, from the main menu of MQ Visual Edit, select File then Register:

Do the following:
• Input the user's name and email address
• Next, click the Yes button to input your license key

• Finally, click the Submit button to get your Access Code.

Note: A license key can ONLY be registered once.
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2.3 Connectivity Issues
This section will describe how to handle registering MQ Visual Edit when the user has connectivity 
issues.

2.3.1 Registering using a Web Browser
Before attempting to register via a web browser, please attempt the instructions in section 2.2 (clicking 
the Submit button).  If you followed the instructions in section 2.2 including setting the Proxy values 
and the registration failed then the end-user can attempt to register via a web browser

Click the Web Browser button to  launch the default web browser on your PC/laptop.

MQ Visual Edit will launch the default web browser on your PC/laptop and then display the following 
popup.
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Your web browser will connect to Capitalware’s online registration server and submit the end-user’s 
information for registering the product.  When the registration process is complete, the web browser 
will display your Access Code.  En email will also be sent to the email address that the end-user 
provided. 

Next, click Add button

Copy and paste the Access Code from the web browser (or email) and then click OK button

MQ Visual Edit User's Guide                                                                                                                   Page 8



2.3.2 Registering by Email

Before attempting to register via an email, please attempt the instructions in section 2.2 (clicking the 
Submit button) and the instructions in section 2.3.1.  If you followed the instructions in section 2.2 
including setting the Proxy values and the registration failed then the end-user can attempt to register 
via a web browser

If MQ Visual Edit cannot make a connection to Capitalware's web server (with or without a Proxy 
Server) or the default web browser cannot make a connection, then the user can email the information 
to 'support@capitalware.com'.  Click the OK button to retrieve the information:

MQ Visual Edit will launch the default email client program on your PC/laptop and create the 
following email which is to be sent to 'support@capitalware.com'.

You will receive the Access Code via email.  Simply click the Add button and input the Access Code.  
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When you receive the reply email from Capitalware Support, do the following:

Click Add button

Copy and paste the Access Code from the reply email and then click OK button.

MQ Visual Edit User's Guide                                                                                                                   Page 10



2.4 A New or Replacement PC or Laptop
This section will describe how to handle inputting your information into MQ Visual Edit for a 
new/replacement PC/laptop after you have previously registered your MQ Visual Edit license key.

It is very common for users to get a new PC/laptop or have Windows re-installed on their PC/laptop.  
The first thing the user needs to do is find the email called 'MQ Visual Edit Access Code' from 
'support@capitalware.com' that they received when they originally registered MQ Visual Edit.  It will 
contain their Access Code.

• First, the user needs install MQ Visual Edit (follow the installation instructions in section 2.1).
• Optional step, the user will want to copy the following 2 files to their new PC/laptop that are 

located in C:\Users\{UserId}\Capitalware\ directory:
◦ QMgrInfo.db
◦ UserFormats.db  (if it exists)

• Finally, the user will need to input their information, License Key and Access Code into MQ 
Visual Edit
◦ Click File -> Register and input your name and email address
◦ Click the Yes button and input the License key
◦ Click Add button and input your Access Code from the email the user previously received
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2.5 Yearly Registration Process
MQ Visual Edit license is for a 1-year subscription.  When the 1-year subscription ends, the license 
key becomes invalid (garbage).  Hence, to continue to use MQ Visual Edit, the end-user will need to 
purchase another license for a 1-year subscription to MQ Visual Edit.  This section will describe how 
to register a new license key during or after an existing 1-year subscription to MQ Visual Edit.

If the end-user is using a previous release of MQ Visual Edit, Capitalware strongly suggests that the 
end-user upgrades to the latest release of MQ Visual Edit.   The order email includes the download link
(with UserId and Password) to the latest commercial release of MQ Visual Edit.  Simply follow the 
upgrade instructions in Appendix B.

To input the license key, from the main menu of MQ Visual Edit, select File then Register.

Do the following:

• Click the Yes button to input your license key

• Input the new license key and then click the OK button
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• Next, click the Submit button to get your Access Code.

Note: A license key can ONLY be registered once.
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2.6 Enterprise License File
This section will describe how to handle the storing of an Enterprise License file.  

Note: This section is only applicable to those customers who have purchased an Enterprise License for 
MQ Visual Edit.

Upon the purchase or renewal of an Enterprise License for MQ Visual Edit, the customer will be 
emailed both the Enterprise License key and the Enterprise License file.    Enterprise License file is 
called 'mqve.license.properties'.  Do not rename the Enterprise License file or modify its contents.

MQ Visual Edit is supported on Windows, macOS and Linux.  The Enterprise License file is designed 
to be deployed to any and all of those platforms.

MQ Visual Edit will look for the Enterprise License file in 1 of 3 directories:

1. The user’s settings directory '{home directory}\Capitalware\' :
◦ On Windows:  C:\Users\{UserId}\Capitalware\
◦ On macOS:     /Users/{UserId}/Capitalware/
◦ On Linux:       /home/{UserId}/Capitalware/

2. The user’s '{home directory}\' :
◦ On Windows:  C:\Users\{UserId}\
◦ On macOS:     /Users/{UserId}/
◦ On Linux:       /home/{UserId}/

3. The MQ Visual Edit install directory:
◦ On Windows:  C:\Capitalware\MQVE3\
◦ On macOS:      not applicable
◦ On Linux:        /apps/Capitalware/MQVE3/

Capitalware recommends putting the Enterprise License file in the user’s settings directory (option #1).
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3 Managing Groups
This chapter will describe how to add, rename and delete a Group.

3.1 Adding a Group
This section will describe how to add a Group to MQ Visual Edit.  A Group will hold 1 or more Queue
Manager Access Profiles.  The Group name can be any name the user wishes.

From the main menu of MQ Visual Edit, select File then Add Group...:

After the user inputs a name, click the OK button to create the new group.

3.2 Renaming a Group
This section will describe how to rename a Group in MQ Visual Edit.

In the Queue Managers' dock, right click on the group name to be renamed, then select Rename 
Group…:

Input a new group name then click the OK button:
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3.3 Deleting a Group
This section will describe how to delete a Group from MQ Visual Edit.  

Note: If the user deletes a group containing Queue Manager Access Profiles then when the group is 
deleted, those Queue Manager Access Profiles will be moved to the default group called '[default]'.  
MQ Visual Edit will not delete the Queue Manager Access Profiles.

In the Queue Managers' dock, right click on the group name to be renamed, then select Delete 
Group…:

Click the Yes button to confirm the deletion of the group.

MQ Visual Edit User's Guide                                                                                                                   Page 16



4 Managing Queue Managers
This chapter will describe how to create, update, test and delete a Queue Manager Access Profile.

4.1 Adding a Queue Manager Access Profile
This section will describe how to add a Queue Manager Access Profile so that you can connect to a 
local or remote queue manager.

From the main menu of MQ Visual Edit, select File then Add Queue Manager Access Profile or the 
user can right click on a group name in the Queue Manager dock and select Add Queue Manager 
Access Profile:

You will be prompted to provide a name for the new Queue Manager Access Profile. It is suggested 
that you provide a meaningful name that describes the queue manager and its location.  Note: Do not 
use semi-colons ";" in the name.

If the queue manager is local to where you are running MQ Visual Edit then all you need to specify is 
the queue manager.

Note: If the queue manager is located in a timezone different from the end-user’s PC/laptop, then the 
end-user can set the timezone to the actual queue manager timezone and then the MQ Visual Edit will 
display the date and time of messages in the queue manager’s timezone (rather than the end-user’s 
timezone).
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If the queue manager is remote to where you are running MQ Visual Edit then the user will also need 
to fill in the fields on the Remote panel.  i.e. Channel Name, IP / Hostname and port number.

If the remote queue manager is configured for IBM MQ MI (Multi-Instance) or IBM MQ HA (High 
Availability) then the following rules must be followed for a successful connection:

• The first hostname or IP address MUST have the port number explicitly set.
• The second hostname or IP address must NOT have the port number explicitly set.
• The port value MUST be set to the correct value for the 2nd hostname or IP address.

If your queue manager is configured to fail over between 2 servers called: serv01 and serv02 and the 
queue manager’s listener is listening on port number 5555 then this is how to set the IP/Hostname and 
Port # fields:

IP/Hostname:   serv01(5555),serv02
Port #:               5555

MQ Visual Edit User's Guide                                                                                                                   Page 18



Specifying a UserId and/or Password. We strongly suggest that all connection made to a remote queue 
manager specify both a UserId and Password.

Note: A blank or unset UserId means that MQ Visual Edit will connect to a Queue Manager and use 
whatever authority the MCA has. At some companies, this type of access is not allowed. Therefore, 
type in your valid UserId (and Password where authentication is required) for the Queue Manager that 
you are connecting to.

For queue managers that perform authentication, the user may wish to be prompted for the password 
rather than have MQ Visual Edit save it.  Click the 'Prompt for Password' checkbox to have MQ Visual
Edit prompt the user for their password for the remote system.

The User identification compatibility mode checkbox allows the user to send the UserId and Password
as done in releases prior to IBM MQ V8.
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Optional:
For those companies that use exits, security, send and/or receive, the user will need to fill in the Class 
Name, Exit Data and Jar File Location.

For example, if you are using Capitalware's MQAUSX solution then the fields would be set as follows:
Class Name:

• biz.capitalware.mqausx.MQAUSXJ 

Jar File Location:
• C:\Capitalware\MQAUSX\MQAUSX.jar

Optional:
For those companies that use SSL/TLS to allow MQ client applications to connect to their queue 
managers, the user will need to fill in the SSL/TLS fields.
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Optional:
For those companies that use IBM MQ Advanced Message Security (AMS), the end-user will need to 
tell MQ Visual Edit where the keystore.conf file (with the JKS keywords and values) is located.  Use 
the Browse button to locate the keystore.conf on the end-user’s PC/laptop.
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4.2 Editing a Queue Manager Access Profile
This section will describe how to edit a Queue Manager Access Profile so that you can connect to a 
local or remote queue manager.

Right click on the queue manager in the 'Queue Manager' dock and select Properties:

The Queue Manager Access Profile will be presented where the user can modify/update the fields and 
when done click the OK button to save the information.
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4.3 Renaming a Queue Manager Access Profile
This section will describe how to rename a Queue Manager Access Profile.

Right click on the queue manager in the 'Queue Manager' dock and select Rename:

Input a new name for the Queue Manager Access Profile then click the OK button.
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4.4 Move a Queue Manager Access Profile to Another Group
This section will describe how to move a Queue Manager Access Profile to another group.

Right click on the queue manager in the 'Queue Manager' dock and select Move To.  A list of available
groups will be displayed and the user simply selects the appropriate group.
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4.5 Deleting a Queue Manager Access Profile
This section will describe how to delete a Queue Manager Access Profile.

Right click on the queue manager in the 'Queue Manager' dock and select Delete:

Click the Yes button to confirm the deletion of the Queue Manager Access Profile.
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4.6 Import Queue Manager Information
This section will describe how to import queue manager information from other products.

Note: During the import process, MQ Visual Edit will NOT display an importing queue manager on 
the Import Queue Managers window if it already exists in the MQ Visual Edit.

4.6.1 Import from MQ Explorer
This section will describe how to import queue manager information from MQ Explorer.  The end-user
will need to first export their queue manager information from MQ Explorer. Do the following in MQ 
Explorer:

• Click File - > Export menu item
• Select MQ Explorer Setting then click the Next button
• Make sure the Connection Information checkbox is select (the other checkboxes are optional)
• Click the Browse button, select an export directory and specify a file name i.e. mqexplorer.xml
• Click the Finish button

Now that the MQ Explorer queue manager information has been exported, we can import it into MQ 
Visual Edit.  Do the following:

• Click File - > Import Queue Manager Settings - > MQ Explorer menu item
• Go to the directory where you saved the MQ Explorer XML file and then select the XML file

MQ Visual Edit will display a list of queue managers from the MQ Explorer XML file that can be 
selected:

Simply select the queue managers you want to be imported, select the Group to be imported in to and 
select a Time Zone then click the OK button to finish the import.
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4.6.2 Import from MO71
This section will describe how to import queue manager information from MO71.  The queue manager
information for MO71 is generally stored in the install directory of MO71.

Do the following:

• Click File - > Import Queue Manager Settings - > MO71 menu item
• Go to the MO71 install directory and then select the MQMON.CFG file

MQ Visual Edit will display a list of queue managers from the MO71 MQMON.CFG file that can be 
selected:

Simply select the queue managers you want to be imported, select the Group to be imported in to and 
select a Time Zone then click the OK button to finish the import.
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4.6.3 Import from MQ Visual Edit V1 or V2
This section will describe how to import queue manager information from MQ Visual Edit V1 or V2.  
The queue manager information for MQ Visual Edit V1 or V2 is stored in the end-user’s home 
directory.

Do the following:

• Click File - > Import Queue Manager Settings - > MQ Visual Edit V1 or V2 menu item
• Go to the directory where the CommProfileDB.properties file is located and select it

MQ Visual Edit will display a list of queue managers from the CommProfileDB.properties file that 
can be selected:

Simply select the queue managers you want to be imported, select the Group to be imported in to and 
select a Time Zone then click the OK button to finish the import.
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4.6.4 Import from a CCDT File
This section will describe how to import queue manager information from a CCDT file.

Do the following:

• Click File - > Import Queue Manager Settings - > CCDT File menu item
• Go to the directory where the CCDT file is located and select it

MQ Visual Edit will display a list of queue managers from the CCDT file that can be selected:

Simply select the queue managers you want to be imported, select the Group to be imported in to and 
select a Time Zone then click the OK button to finish the import.
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4.6.5 Import Local Queue Managers
This section will describe how to import queue manager information from local queue managers (if the
end-user has MQ server installed). 

Note: On the initial install and usage of MQ Visual Edit, it will collect local queue managers and 
display the Import Queue Managers window with the local queue managers (if any exist).

Do the following:

• Click File - > Import Queue Manager Settings - > Local Queue Managers menu item

MQ Visual Edit will display a list of queue managers from the CCDT file that can be selected:

Simply select the queue managers you want to be imported, select the Group to be imported in to and 
select a Time Zone then click the OK button to finish the import.

Note: Any time the end-user adds a local queue manager to their system, simply follow the above 
instructions and MQ Visual Edit will display the Import Queue Managers window with all local 
queue managers that do not exist in MQ Visual Edit.
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5 Managing a Queue
This chapter will describe the process of selecting, opening and managing a IBM MQ queue.

5.1 Retrieving a List of Queues
This section will describe how to retrieve a list of queues from a local or remote queue manager.

Right click on the queue manager in the 'Queue Manager' dock and select List Queues:

Or the user can do the following, from the main menu of MQ Visual Edit, select Queue, select Open 
Queue and then click the List button. On the Open Queue panel, select the Queue Manager Access 
Profile that you want to use.

You may optionally:
• Display the SYSTEM.* queues when the mask is set to "*" by selecting or deselecting the 

Show System Queues checkbox.
• Display temporary dynamic queues when the mask is set to "*" by selecting or deselecting the 

Show Temporary Queues checkbox.
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Now click the List button to retrieve a list of queues from a local or remote queue manager.

For queue managers with hundreds or thousands of queues, you can filter the queue list returned to the 
user by specifying a mask value. ABC.* will return only those queue names that begin with "ABC."
i.e.
ABC.HR.Q
ABC.PAYROLL.CHECK
ABC.SUPPLY.CHAIN.NTR

The user can also combine mask filters together. Use a semi-colon (;) to separate each mask.
i.e.
ABC.*;XYZ.*;TEST.*

Hence, only queues that begin with 'ABC.', 'XYZ.' and/or 'TEST.' will be shown.

You may also choose to view only a certain type of queue. You may select the queue type from one of 
the following:

• ALL
• Local Queues only
• Alias Queues only
• Remote Queues only
• Cluster Queues only
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Select a queue from the list that you wish to interact with and then click the Select button.

There are 4 options the user can select:
• Select - Selects the currently highlighted queue and returns to the Open Queue window.
• Open - Opens 1 or more queues and leaves the 'List of Queues' window open.
• Refresh - Refreshes the current list of queues.
• Close - Closes the 'List of Queues' window.
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5.2 Opening a Queue
This section will describe how to open queue of a local or remote queue manager. 

Right click on the queue manager in the 'Queue Manager' dock and select Open Queue then select the 
queue name from the list:

Or from the main menu of MQ Visual Edit, select Queue then Open Queue. On the Open Queue 
panel, select the Queue Manager Access Profile that you want to use.

The following is the Open Queue Dialog panel:

There are 3 ways to input a queue name:
1. Type a queue name into the Queue Name field (e.g. TEST.Q1 ) and click the Open button.
2. Use the drop-down box to select a previously inputted queue name.
3. You may also use the List button to retrieve a queue name.

You may select a range of messages i.e. 1100 to 1200 to be displayed rather than all messages in the 
queue.  The user can also select whether the messages are converted on the get or not.
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There are 2 types of options that you can selected: Convert on Get and Context.

• Convert on Get - this option will instruct MQ Visual Edit to perform a MQGET with the 
convert option specified. Any message with a different CCSID and / or Encoding will be 
convert to the local CCSID and /or Encoding (Note: The MQMD.Format field must have the 
appropriate value specified.).

• Open Read Only - this option will disable all features that changed or save the message.
• Context - this option will instruct MQ Visual Edit on what MQMD Context values should be 

specified when putting a message to a queue.

Note: For z/OS queue managers, for a shared queue, select the "Shared queue on z/OS" checkbox.  If 
the queue is not a shared queue then leave the checkbox unchecked.   If the shared queue is indexed by 
Correlation ID then the user needs to select Correlation ID radio button on the Open Queue window. 
Otherwise, the user will receive Reason Code of 2206.

Now that you have selected a Queue Manager Access Profile in the Queue Manager Dock and filled in 
the Queue Name field, select the Open button to open the queue.

If you typed TEST.Q1 then main panel may look something like: 

You can open a second, third, etc... by selecting Queue then Open Queue. On the Open Queue panel, 
select the Queue Manager Access Profile and queue that you would like to open.
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5.3 Refreshing a Queue
This section will describe how to refresh the contents of a queue.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Queue, then Refresh Queue.

After the refresh is performed, any new messages added to the queue (since the last time opened or 
refreshed) will be displayed to the user.
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5.4 Closing a Queue
This section will describe how to close an open queue.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Queue, then Close Queue.

Performing the Close queue option, disconnects from the queue manager and clears the main panel 
display.

If the user has one or more queues open, then a quick and convenient way to close all of the queues is 
to select Queue, then Close All Queues.
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5.5 Backing up a Queue
This section will describe how to backup all or selected messages in a queue including the MQMD and
the message data to a Backup file.  A Backup file can be either a SQLite Database or a VEQ formatted 
file.

If you have previously opened TEST.Q1, the main panel may look something like:

First, select one or more messages in the queue, then from the main panel of MQ Visual Edit, select 
Queue, then Backup Queue.

The user can select the type of Backup file (SQLite database or VEQ formatted file), the directory 
and/or filename and whether the messages should be appended or a new file is to be created.
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To change the directory, click the Browse button and then select a new directory and the name of file 
then click Save.

Once the user is happy with the values on the Backup Queue window, then click the Save button.  
When the selected messages have been successfully backed up, you will be notified.
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5.6 Restoring a Queue
This section will describe how to restore messages to a queue from a Backup file.  A Backup file can 
be either a SQLite Database (*.mqsdb) or a VEQ formatted file (*.veq).

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Queue, then Restore Queue.

Select the directory and a MQVE Backup File (*.mqsdb or *.veq) then click Open.

After the Restore action has been performed, the main panel may look something like (green means the
messages were inserted):
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5.7 Clearing a Queue
This section will describe how to clear the contents of a queue.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Queue, then Clear Queue.

Click Yes if you are sure that you want the delete ALL of the messages on the queue.
Note: There is no undo function for the Clear Queue option.

You will be notified when the queue has been cleared.

After the Clear Queue action has been performed, the main panel may look something like (red means 
messages were deleted):
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5.8 Clearing a Queue by ID
This section will describe how to clear messages from a queue that match a Message ID or Correlation 
ID or both.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Queue then Clear Queue by ID.

Input a hexadecimal string (HEX) into the Message ID or Correlation ID or both fields. It MUST be 48
digits long.  Make sure to click the appropriate check box (Message ID or Correlation ID or both) for 
the search criteria.  You may also invert the search and deletion of messages. Click the "Remove all 
messages without matching ID(s)", to delete all messages that do NOT contain the user specified 
search string.

Click Ok to proceed to the next step. It will now search the queue for messages match the user's search
string.

Click Yes if you are sure that you want the to delete the number of messages specified.
Note: There is no undo function for the Clear Queue option.
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After the Clear Queue action has been performed, the main panel may look something like (red means 
messages were deleted):
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5.9 Clearing a Queue by Time
This section will describe how to clear messages from a queue that are older than "x" hours or "x" 
days.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Queue then Clear Queue by Date/Time.

Input a number value and then select the radio button that the value represents (i.e. hours or days).

Click Ok to proceed to the next step. It will now search the queue for messages older than the criteria 
you specified.

Click Yes if you are sure that you want the to delete the number of messages specified.
Note: There is no undo function for the Clear Queue option.
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After the Clear Queue action has been performed, the main panel may look something like (red means 
messages were deleted):
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5.10Clearing a Queue by Matching String
This section will describe how to clear messages from a queue that match a particular string.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Queue then Clear Queue by Matching String.

Input a string (alpha or numeric) that you wish to match messages on. The user may also select the 
"Case Sensitive" check box to make the search process case sensitive.

You may also invert the search and deletion of messages. Click the "Remove all messages without the 
search string", to delete all messages that do NOT contain the user specified search string.

Click Ok to proceed to the next step. It will now search the queue for messages match the user's search
string.

Click Yes if you are sure that you want the to delete the number of messages specified.
Note: There is no undo function for the Clear Queue option.
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After the Clear Queue action has been performed, the main panel may look something like (red means 
messages were deleted):
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6 Managing a Topic
This chapter will describe the process of selecting, opening and managing a IBM MQ topic.

6.1 Retrieving a List of Topics
This section will describe how to retrieve a list of topics from a local or remote queue manager.

Right click on the queue manager in the 'Queue Manager' dock and select List Topics:

Or the user can do the following, from the main menu of MQ Visual Edit, select Topic, select Open 
Topic and then click the List button. On the Open Topic panel, select the Queue Manager Access 
Profile that you want to use.

You may optionally display the SYSTEM.# topics when the mask is set to "#" by selecting or 
deselecting the Show System Topics checkbox.

Now select the List button to retrieve a list of topics from a local or remote queue manager.
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For queue managers with hundreds or thousands of topics, you can filter the topic list returned to the 
user by specifying a mask value. XYZ# will return only those topic names that begin with "XYZ"
i.e.
XYZ/PAYROLL/CUTOFF
XYZ/SUPPLY/CHAIN

The user can also combine mask filters together. Use a semi-colon (;) to separate each mask.
i.e.
ABC#;XYZ#;TEST#

Hence, only topics that begin with 'ABC', 'XYZ' and/or 'TEST' will be shown.

Select a topic from the list that you wish to interact with and then click the Select button.

There are 4 options the user can select:
• Select - Selects the currently highlighted topic and returns to the Open Topic window.
• Open - Opens 1 or more topics and leaves the 'List of Topics' window open.
• Refresh - Refreshes the current list of topics.
• Close - Closes the 'List of Topics' window.
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6.2 Opening a Topic
This section will describe how to open topic of a local or remote queue manager. 

Right click on the queue manager in the 'Queue Manager' dock and select Open Topic then select the 
topic name from the list:

or from the main menu of MQ Visual Edit, select Topic then Open Topic. On the Open Topic panel, 
select the Queue Manager Access Profile that you want to use.

The following is the Open Topic Dialog panel:

There are 3 ways to input a topic name:
1. Type a topic string into the Topic String field (e.g. test/one ) and click the Open button.
2. Use the drop-down box to select a previously inputted topic name.
3. You may also use the List button to retrieve a topic name.

The Topic Name is the name of a predefined node in the topic tree.  An administrator can define 
certain nodes within a topic tree as administered nodes.  The administered nodes can have properties 
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assigned to them.  They are generally used for security purposes.  Administered nodes are given a 
name (up to 48 characters).  If a topic name is specified the node serves as the base (root node) that the 
topic string starts from.  The topic name does not have to have any relationship with the actual location
within a topic tree.

The use of topic names is optional.  The entire topic string can be entered within the topic string field.  
If a topic name is used then the topic string should be relative to this point in the topic tree.

There are 2 types of options that you can selected: Convert on Get and Context.

• Convert on Get - this option will instruct MQ Visual Edit to perform a MQGET with the 
convert option specified. Any message with a different CCSID and / or Encoding will be 
convert to the local CCSID and /or Encoding (Note: The MQMD.Format field must have the 
appropriate value specified.).

• Open Read Only - this option will disable all features that changed or save the message.
• Context - this option will instruct MQ Visual Edit on what MQMD Context values should be 

specified when putting a message to a topic.

Now that you have selected a Queue Manager Access Profile and filled in the Topic Name field, select 
the Open button to open the topic.

If you typed testTopic then main panel may look something like: 

You can open a second, third, etc... by selecting Topic then Open Topic. On the Open Topic panel, 
select the Queue Manager Access Profile and topic that you would like to open.

Note: The topic displayed will be automatically updated as new topic messages arrive.  Hence, there is 
no refresh menu item or toolbar button.
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6.3 Closing a Topic
This section will describe how to close an open topic.

If you have previously opened testTopic, the main panel may look something like:

From the main panel of MQ Visual Edit, select Topic, then Close Topic.

Performing the Close topic option, disconnects from the queue manager and clears the main panel 
display.

If the user has one or more topics open, then a quick and convenient way to close all of the topics is to 
select Topic, then Close All Topics.
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6.4 Backing up a Topic
This section will describe how to backup all or selected messages in a queue including the MQMD and
the message data to a Backup file.  A Backup file can be either a SQLite Database or a VEQ formatted 
file.

If you have previously opened testTopic, the main panel may look something like:

First, select one or more messages in the topic, then from the main panel of MQ Visual Edit, select 
Topic, then Backup Topic.

The user can select the type of Backup file (SQLite database or VEQ formatted file), the directory 
and/or filename and whether the messages should be appended or a new file is to be created.
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To change the directory, click the Browse button and then select a new directory and the name of file 
then click Save.

Once the user is happy with the values on the Backup Topic window, then click the Save button.  
When the selected messages have been successfully backed up, you will be notified.
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6.5 Restoring a Topic
This section will describe how to restore messages to a topic from a Backup file.  A Backup file can be
either a SQLite Database (*.mqsdb) or a VEQ formatted file (*.veq).

If you have previously opened testTopic, the main panel may look something like:

From the main panel of MQ Visual Edit, select Topic, then Restore Topic.

Select the directory and a MQVE Backup file (*.mqsdb or *.veq) then click Open.

After the Restore action has been performed, the main panel may look something like (green means the
messages were inserted):
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7 Manipulating the Messages
This chapter will describe the process of selecting, opening and managing a IBM MQ queue and topic.

7.1 Cut a Message
This section will describe how to cut a message from the queue or topic and store it in the system 
clipboard.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Cut Message.

Click Yes if you are sure that you want the message to be deleted.
Note: There is no undo function for the delete message option.

The main panel is updated with the message cut from the queue (red means messages were deleted).
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7.2 Copy a Message
This section will describe how to copy a message from the queue or topic and store it in the system 
clipboard.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Copy Message.

There will be no change to the main panel. The copy action copies the message contents to the system 
clipboard.
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7.3 Paste a Message
This section will describe how to paste a message from the system clipboard to the opened queue or 
opened topic.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Paste Message.

The main panel is updated with the message pasted from the system clipboard.
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7.4 Edit a Message
This section will describe how to edit a message in the opened queue or topic.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

You can now edit, updated or delete sections of the message text. Clicking the Save button will delete 
the old copy of the message and insert the new updated message into the queue.  From the Message 
Edit panel, the user can select to save the contents to a file or load data from a file. Click the Load 
button to load data from a file or click the Save button to save the message data to a file.  For more 
information about the features / functions for the Raw tab, go to the Raw Data section in Chapter 8.
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The main panel is updated with the new message from the editing session:
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7.5 Edit a Message in Hex
This section will describe how to edit a message in Hex from the opened queue or topic.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message in Hex.

You can now edit in hex sections of the message text. Clicking the Save button will delete the old copy
of the message and insert the new updated message into the queue.

The main panel is updated with the new message from the editing session.
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7.6 Edit a Message with XML Editor
This section will describe how to edit a message with the XML Editor from the opened queue or topic.

If you have previously opened TEST1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message with XML Editor.

You can now edit the message using the XML Editor. Clicking File then Save to Queue button will 
delete the old copy of the message and insert the new updated message into the queue.

The main panel is updated with the new message from the editing session.
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7.7 Insert a Message
This section will describe how to insert a message into an opened queue or topic.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Insert Message.

The Insert Message Wizard is designed to help the user quickly create 7 different MQ message 
formats. i.e. None, String, RFH, RFH2 (JMS), IMS, CICS and R3/SAP.  The user can alter the 
contains of the Message Descriptor and/or Named Properties. Plus if the user selects RFH, RFH2 
(JMS), IMS, CICS or R3/SAP message format, the user can alter those values too.  Click File -> Save 
to Queue to save the message to the queue or topic.

The main panel is updated with the new message.
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7.8 Duplicate a Message
This section will describe how to duplicate a message in the opened queue or topic.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Duplicate Message.

The user will be prompted to select either a new message id or copy the message id for each new 
message.

The main panel will be updated with the newly inserted message.
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7.9 Forward a Message
This section will describe how to forward a message from an opened queue or topic.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Forward Message.

Now specify a destination queue name and then click the Ok button You can use the List button to 
help you select a valid queue name.  If the message has a DLH (Dead Letter Header) and you would 
like it to be stripped off during the forwarding, then click the Remove Dead Letter Header checkbox.

Click Yes if you are sure that you want the message to be forwarded.
Note: There is no undo function for the forward message option.

The main panel is updated.
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7.10Delete a Message
This section will describe how to delete a message from an opened queue or topic.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Delete Message.

Click Yes if you are sure that you want the message to be deleted.
Note: There is no undo function for the delete message option.

The main panel is updated.
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7.11Compare a Message to a File
This section will describe how to compare the contents of a message to file.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Compare a Message to a File.

The user now selects the file to compare the message contents against.

The user now selects the file to compare the message contents against.
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7.12Printing a Message
This section will describe how to print a message to a printer from an opened queue.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Print Message.

The user now selects the printer to print the message on.

MQ Visual Edit User's Guide                                                                                                                   Page 68



7.13Generate Report
This section will describe how to generate a report (PDF, RTF or HTML) from the selected messages.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Generate Report.

The user now selects how the messages are to be generated into the report:

• The user may use the Browse button to select the directory and file name to be used for the 
report file.

• The user can select PDF or RTF or HTML for the report type.
• The user can select Raw Data or Hex Data or EBCDIC Hex for how the message data will be 

formatted in the report.

The user can select to include the message's Message Descriptor and/or Named Properties in the report.
Click Save to generate the report.

Click Ok
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7.14Importing Files
This section will describe how to import one or more files as message into an opened queue or topic.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Insert File.

Now select one or more files or change directories to locate the files and then click Open
Note: You can select more than one file in this dialog box. Use either the Shift or Ctl keys when 
selecting the files.
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The Import File Wizard is designed to help the user quickly create 7 different MQ message formats. 
i.e. None, String, RFH, RFH2 (JMS), IMS, CICS and R3/SAP.

The user can alter the contains of the MQMD. Plus if the user selects RFH, RFH2 (JMS), IMS, CICS 
or R3/SAP message format, the user can alter those values too.

There are 3 file options when importing files:

• Each file as a message
• Every line of each file - a message will be created for each line (record) in every individual file
• Delimited File – the file will be parsed, based on the delimiter, into sections and each parsed 

section will be a message.

Note: The Import File Wizard will put all messages to the queue using the MQ message format that the
user creates in this step.

The main panel is updated with the 3 new messages.
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7.15Exporting Messages
This section will describe how to export a message to a file from an opened queue or topic.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Export Message.

The user now selects how the messages are to be outputted to a file:

• Select Each message to a separate file for separate files for each message in the queue.
• Select All selected messages to the same file for 1 (one) output file. The single file will 

contain all selected messages that will be exported.

Trailor Text
• Select Append Trailer Text to add user defined text to the end of each message as it is saved 

to the file. Use "\n" to represent CRLF on Windows and LF on Unix/Linux.

The user may use the Browse button to select the directory and file name to be used for the exporting.  
Click Save to export the messages to a file.

Click Ok.
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7.16Find
This section will describe how to use the Find feature. The Find function allows the user to search the 
messages of the queue for a particular text string.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Find.

After clicking Find, if a match is found, the table cell containing the matching string will be 
highlighted in yellow.

When you are done searching, click the Cancel button. The row containing the last matching search 
string will be highlighted.
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8 Message Edit
This chapter will describe the various docks of the Message Edit window.

8.1 Message Data Dock
This section will describe how to edit a message in the opened queue.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

You can now edit, updated or delete sections of the message text. Clicking the File -> Save to Queue 
will delete the old copy of the message and insert the new updated message into the queue.
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If the user has unselected the “Automatically retrieve the entire message data when opening the 
'Message Edit' window” option on the MQ Queue panel of the Preferences window then if the message
is larger than the “Maximum size of each message to retrieve” option then MQ Visual Edit will enable 
the “Get All Data” menu item (under File) on the Message Edit window.

The following are the dropdown menus that currently exist for the Message Edit Window.

Under File:
• Load from File - Allows the user to load (import) the contains of a text file into the current 

message text.
• Get All Data – if the retrieved message data is smaller than the actual message size then this 

menu item will be enable.
• Save to File - Allows the user to save the message content to a plain text file.
• Save to Queue - Allows the user to save the message back to the queue (use this function after 

a change or update to the message content or the message's MQMD header.)
• Print Message - Allows the user to print the message
• Close - Allows the user to discard the Message Edit window and return to the main window.

Under Edit:
• Cut - Allows user to cut part or all of the message content to the system's clipboard.
• Copy - Allows user to copy part or all of the message content to the system's clipboard.
• Paste - Allows user to paste from the system's clipboard into the message content.
• Find - Provides the user with the ability to search the message content for a specific string.
• Replace - Provides the user with the ability to search the message content for a specific string 

and replace the string with another string.

Under Message:
• User Formats - Allows user to define a message format for the data.
• Apply Format - Allows user to apply a specific message format to the data.

Under View:
• Wrap Text - Allows the user to toggle the message content's display between wrapped and 

unwrapped text.
• Select All - Allows the user to quickly select all of the message's content.
• Unselect All - Turns the selection off (if on) and sets the cursor to column 1 of row 1.

Under Help:
• Help - Allows the user to display the MQ Visual Edit User Guide.
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In the message content window of the Message Data dock, if the user performs a right-mouse click 
then a popup window will be displayed. The user will be able to do the following:

• Cut - Allows user to cut part or all of the message content to the system's clipboard.
• Copy - Allows user to copy part or all of the message content to the system's clipboard.
• Paste - Allows user to paste from the system's clipboard into the message content.
• Find - Provides the user with the ability to search the message content for a specific string.
• Load from File - Allows the user to load (import) the contains of a text file into the current 

message text.
• Save to File - Allows the user to save the message content to a plain text file.

The main panel is updated with the new message from the editing session:
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8.2 XML Viewer Dock
This section will describe how to view a message in the opened queue. If the data is well formed XML 
then the XML Viewer will be able to display it.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message then click the XML 
Viewer button.

The XML data is shown in a tree view. The user can expand any entry they wish to. This will allow 
them to view attributes, nodes and data with the XML data.  
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8.3 JSON Viewer Dock
This section will describe how to view a message in the opened queue. If the data is well formed JSON
then the JSON Viewer will be able to display it.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message then click the JSON 
Viewer.

The JSON data is presented in a formatted view.  
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8.4 Fixed Width Viewer Dock
This section will describe how to view a message in the opened queue. If a Fixed Width format has 
been created then data can be formatted using it.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message then click the Fixed 
Width Viewer button.

If there is a Fixed Width user format defined for the opened queue then MQ Visual Edit will 
automatically use it when the Fixed Width Viewer dock button is clicked.

If there is no Fixed Width user format defined for the opened queue then the user can manually select 
one of the Fixed Width user formats by clicking Message - > Apply Format - > XXXX where XXXX 
is one of the Fixed Width user formats.
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8.5 CSV Viewer Dock
This section will describe how to view a message in the opened queue. The data can be viewed with or 
without a CSV format.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message to open the message in 
the Message Edit window.
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Click the CSV Viewer button to view the message in the CSV Viewer.

If there is a CSV user format defined for the opened queue then MQ Visual Edit will automatically use
it when the CSV Viewer dock button is clicked.

Note: If a CSV format is not being used and the first row of data contains the header row, then click 
View - > Use first row for column names menu item to display it.

If there is no CSV user format defined for the opened queue then the user can manually select one of 
the CSV user formats by clicking Message - > Apply Format - > XXXX where XXXX is one of the 
CSV user formats.
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8.6 FIX Viewer Dock
This section will describe how to view a message in the opened queue. The data can be viewed with or 
without a FIX format.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message to open the message in 
the Message Edit window.
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Click the FIX Viewer button to view the message in the FIX Viewer.

If there is a FIX user format defined for the opened queue then MQ Visual Edit will automatically use 
it when the FIX Viewer dock button is clicked.

Note: If a FIX format is not being used and the first row of data contains the header row, then click 
View - > Use first row for column names menu item to display it.

If there is no FIX user format defined for the opened queue then the user can manually select one of 
the FIX user formats by clicking Message - > Apply Format - > XXXX where XXXX is one of the FIX
user formats.
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8.7 Hex Data Dock
This section will describe how to edit a message in the opened queue.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

In the columns of 0,1,2,3,4,5,6,7,8,9,0,A,B,C,D,E,F, you can alter the message content by using 
hexadecimal values. Clicking the Save button will delete the old copy of the message and insert the 
new updated message into the queue.

Under File:
• Save to Queue - Allows the user to save the message back to the queue (use this function after 

a change or update to the message content or the message's MQMD header.)
• Print Message - Allows the user to print the message.

Under Edit:
• Copy - Allows user to copy part or all of the message content to the system's clipboard.
• Find - Provides the user with the ability to search the message content for a specific string.

Under Help:
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• Help - Allows the user to display the help files.

In the Hex Data tab, if the user performs a right-mouse click then a popup window will be displayed. 
The user will be able to do the following:

• Copy - Allows user to copy part or all of the message content to the system's clipboard.
• Find - Provides the user with the ability to search the message content for a specific string.
• Close - Close the Message Edit window.

The main panel is updated with the new message from the editing session:
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8.8 EBCDIC Hex Data Dock
This section will describe how to edit a message in the opened queue. Use this tab when the data is in 
EBCDIC format but the message's MQMD does not have the Format field set to reflect the EBCDIC 
content.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

In the columns of 0,1,2,3,4,5,6,7,8,9,0,A,B,C,D,E,F, you can alter the message content by using 
hexadecimal values. Clicking the Save button will delete the old copy of the message and insert the 
new updated message into the queue.

Under File:
• Save to Queue - Allows the user to save the message back to the queue (use this function after 

a change or update to the message content or the message's MQMD header.)
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• Print Message - Allows the user to print the message.

Under Edit:
• Copy - Allows user to copy part or all of the message content to the system's clipboard.
• Find - Provides the user with the ability to search the message content for a specific string.

Under Help:
• Help - Allows the user to display the help files.

In the Hex Data tab, if the user performs a right-mouse click then a popup window will be displayed. 
The user will be able to do the following:

• Copy - Allows user to copy part or all of the message content to the system's clipboard.
• Find - Provides the user with the ability to search the message content for a specific string.
• Close - Close the Message Edit window.

The main panel is updated with the new message from the editing session:
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8.9 Message Descriptor Dock
This section will describe how to edit a message in the opened queue.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

The user may alter any value on any of the Message Descriptor dock: General, Report, Context, 
Identifiers, Segmentation or Attributes. For more information about editing the Message Descriptor, 
go to chapter 9.  Clicking the Save button will delete the old copy of the message and insert the new 
updated message into the queue.

The main panel is updated with the new message from the editing session:
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8.10Named Properties Dock
This section will describe how to edit a message in the opened queue.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

You can now edit, updated or delete sections of the message text. Clicking the File -> Save to Queue 
will delete the old copy of the message and insert the new updated message into the queue.

The user may add/edit/delete any value on any of the Named Properties dock.  For more information 
about editing the Message Descriptor, go to chapter 9.  Clicking the Save button will delete the old 
copy of the message and insert the new updated message into the queue.

The main panel is updated with the new message from the editing session:
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8.11CICS Dock
This section will describe how to edit a message in the opened queue. If the selected message has been 
formatted with a MQCIH header then the MQCIH tab will appear on the Message Edit window.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

The MQCIH header has been parsed into easy to read fields.  Clicking the Save button will delete the 
old copy of the message and insert the new updated message into the queue.
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8.12MQDEAD Dock
This section will describe how to edit a message in the opened queue. If the selected message has been 
formatted with a MQDEAD header (i.e. in the queue manager's dead letter queue) then the MQDEAD 
tab will appear on the Message Edit window.

If you have previously opened SYSTEM.DEAD.LETTER.QUEUE, the main panel may look 
something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

The MQDEAD header has been parsed into easy to read fields.  Clicking the Save button will delete 
the old copy of the message and insert the new updated message into the queue.

To help in problem resolution, the reason code has been translated into Reason Text. If this is not 
enough information to determine what the problem is, then click the More button.
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8.13MQEVENT Dock
This section will describe how to edit a message in the opened queue. If the selected message has been 
formatted with a MQEVENT header then the MQEVENT tab will appear on the Message Edit 
window.

If you have previously opened SYSTEM.ADMIN.PERFM.EVENT, the main panel may look 
something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

The MQEVENT header has been parsed into easy to read fields.
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8.14MQHSAP Dock
This section will describe how to edit a message in the opened queue. If the selected message has been 
formatted with a MQHSAP header then the MQHSAP tab will appear on the Message Edit window.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

The MQHSAP header has been parsed into easy to read fields.  Clicking the Save button will delete 
the old copy of the message and insert the new updated message into the queue.
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8.15IMS Dock
This section will describe how to edit a message in the opened queue. If the selected message has been 
formatted with a MQIIH header then the MQIIH tab will appear on the Message Edit window.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

The MQIIH header has been parsed into easy to read fields.  Clicking the Save button will delete the 
old copy of the message and insert the new updated message into the queue.
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8.16MQRFH Dock
This section will describe how to edit a message in the opened queue. If the selected message has been 
formatted with a MQRFH header then the MQRFH tab will appear on the Message Edit window.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

The MQRFH header has been parsed into easy to read fields.  Clicking the Save button will delete the 
old copy of the message and insert the new updated message into the queue.
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8.17MQRFH2 Dock
This section will describe how to edit a message in the opened queue. If the selected message has been 
formatted with a MQRFH2 header then the MQRFH2 tab will appear on the Message Edit window.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

The MQRFH2 header has been parsed into easy to read fields.  Clicking the Save button will delete the
old copy of the message and insert the new updated message into the queue.
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8.18MQXMIT Dock
This section will describe how to edit a message in the opened queue. If the selected message has been 
formatted with a MQXMIT header then the MQXMIT tab will appear on the Message Edit window.

If you have previously opened CSQ6.XMIT, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

The MQXMIT header has been parsed into easy to read fields.  Clicking the Save button will delete 
the old copy of the message and insert the new updated message into the queue.
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8.19SMQBAD Dock
This section will describe how to edit a message in the opened queue. If the selected message has been 
formatted with a SMQBAD header then the SMQBAD tab will appear on the Message Edit window.

If you have previously opened TEST.BAD, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

The SMQBAD header has been parsed into easy to read fields.  Clicking the Save button will delete 
the old copy of the message and insert the new updated message into the queue.

To help in problem resolution, the reason code has been translated into Reason Text. If this is not 
enough information to determine what the problem is, then click the More button.
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8.20MQDH Dock
This section will describe how to edit a message in the opened queue. If the selected message has been 
formatted with a MQDH header then the MQDH tab will appear on the Message Edit window.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

The MQDH header has been parsed into easy to read fields.  Clicking the Save button will delete the 
old copy of the message and insert the new updated message into the queue.
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8.21MQMDE Dock
This section will describe how to edit a message in the opened queue. If the selected message has been 
formatted with a MQMDE header then the MQMDE tab will appear on the Message Edit window.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

The MQMDE header has been parsed into easy to read fields.  Clicking the Save button will delete the 
old copy of the message and insert the new updated message into the queue.
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8.22MQRMH Dock
This section will describe how to edit a message in the opened queue. If the selected message has been 
formatted with a MQRMH header then the MQRMH tab will appear on the Message Edit window.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

The MQRMH header has been parsed into easy to read fields.  Clicking the Save button will delete the 
old copy of the message and insert the new updated message into the queue.
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8.23MQTM Dock
This section will describe how to edit a message in the opened queue. If the selected message has been 
formatted with a MQTM header then the MQTM tab will appear on the Message Edit window.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

The MQTM header has been parsed into easy to read fields.  Clicking the Save button will delete the 
old copy of the message and insert the new updated message into the queue.
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8.24MQWIH Dock
This section will describe how to edit a message in the opened queue. If the selected message has been 
formatted with a MQWIH header then the MQWIH tab will appear on the Message Edit window.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Message, then Edit Message.

The MQWIH header has been parsed into easy to read fields.  Clicking the Save button will delete the 
old copy of the message and insert the new updated message into the queue.
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9 Message Properties
This chapter will describe how to edit, display, hide or customize the fields of the Message Descriptor 
(MQMD) and/or Named Properties.  The user can select to edit only the Message Descriptor and/or 
Named Properties of a message.

9.1 Edit Message Descriptor
This section will describe how to edit message's Message Descriptor and/or Named Properties.

If you have previously opened the queue TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Properties, then Edit Properties.

9.1.1 Message Descriptor
There are 6 panels on the Message Descriptor dock in the Properties for Message dialog:  General, 
Report, Context, Identifiers, Segmentation and Attributes.  The user can select any panel and edit a 
field's data. When the user is done editing the Message Descriptor attributes, click the Save button to 
save the message and it's attributes.
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9.1.2 Named Properties
The Named Properties for the message are listed in a table.

The user can add/update/delete properties in the table.  When the user is done editing the Named 
Properties, click the Save button to save the message and it's properties.
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9.2 Search Message Descriptor
This section will describe how to Search message's Message Descriptor (MQMD).

If you have previously opened the queue TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Properties, then Search Message Descriptor. Click 
the checkbox next to the Message Descriptor field you wish to search on then input your search value.

After clicking Ok, if a match is found, the table row containing the matching string will be highlighted 
in yellow.
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9.3 Search Next Message Descriptor
This section will describe how to Search Next message's Message Descriptor (MQMD).

If you have previously opened the queue TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Properties, then Search Next Message Descriptor.

Click the checkbox next to the Message Descriptor field you wish to search on then input your search 
value.

After clicking Ok, if a match is found, the table row containing the matching string will be highlighted 
in yellow or the following 'not found'  popup window when all of the messages have been searched.
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9.4 Show Message Descriptor
This section will describe how to show (turn on) the columns with the Message Descriptor (MQMD) 
data.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Properties, then Show Message Descriptor Columns.

The Message Descriptor is contained within 27 columns. The Message Descriptor columns have been 
inserted to be the first 27 columns displayed to the user. Note: Side the horizontal scroll bar to see your
data.
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9.5 Hide Message Descriptor
This section will describe how to hide (turn off the columns) with the Message Descriptor (MQMD) 
data.

If you have previously opened the queue TEST.Q1 showing the Message Descriptor data, the main 
panel may look something like:

From the main panel of MQ Visual Edit, select Properties, then Hide Message Descriptor Columns.

The main panel main panel may look something like:
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9.6 Choose Message Descriptor Columns
This section will describe how to choose the Message Descriptor columns that will be displayed to the 
user.

If you have previously opened the queue TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Properties, then Choose Columns.

The Modify Columns dialog box will be displayed.  Select items in either the left or right panels to 
enable the selection of the column names.

Click the Save button to save the updated column information.
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10 User Formats
This chapter will describe how to create, update and delete user defined formats.  User formats allows 
the end-user to define formats for user specific data.  Currently, MQ Visual Edit supports 3 different 
types of user formats:

• Fixed Width format
• CSV (Comma Separated Value) format
• FIX (Financial Information eXchange) format

MQ Visual Edit can import a COBOL CopyBook as a Fixed Width format.

There are 2 ways to access the user formats in MQ Visual Edit:

• On the main window, click Message - > User Formats
• On the edit window, click Message - > User Formats
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10.1Fixed Width Format
This section will describe how to add, edit and delete Fixed Width formats.

10.1.1 Add a Fixed Width Format
This section will describe how to add a Fixed Width format.  

First, click the Add button, input a unique name for this new Fixed Width Format and click the OK 
button. 
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10.1.1.1 Import COBOL Copybook

Rather than manually inputting all of the fields of a COBOL Copybook, the user can use the Import 
button to parse and load the fields from the COBOL Copybook, into the Fixed Width Layout window. 

Next, the user selects the COBOL Copybook file and any options the user wants.

Normally, COBOL code is written starting in column 6 and ending at column 71.  If your code is 
different then simply select the start and end positions of the code in the COBOL Copybook file.

The user may wish to prefix the group name to the field name.  If so, click the checkbox and then 
select the concatenation character to be used.
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10.1.1.2 Field Definition

Next, on the Fixed Width Layout window, the user can add fields to the layout format by clicking the 
Add button.

Input a name for the field, select the type of data that is represented by this field, the start position and 
the length of the field then click the OK button.

Note: For Type field, do not select Integer, Double, Float, Long or Short if the data is NOT in binary 
format representation of the field.  Also, the Endianess applies to Integer, Double, Float, Long and 
Short binary fields on how the binary data is laid out.

The Type for Table Sorting field, how the Java Table is to treat the data for sorting of the column.

10.1.1.3 Remove first (header) row from data
The Remove first (header) row from data states if the first row of data should or should not be 
displayed to the end-user.
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10.1.1.4 Record Separator
The Record Separator states how each row is laid out in the message data.  The default is “New Line”.
The user can change it to one of the other values in the dropdown.

10.1.1.5 Object Names to be formatted
The Object Names to be formatted is a list of queues and topics that the format will be automatically 
applied to when the user clicks the Fixed Width Viewer in the Edit Message Window.  This parameter 
is optional.

The Object Names to be formatted can be the fully qualified queue or topic name or it can be a regular
expression pattern.

In the regular expression pattern:
• '*' matches any sequence of characters (zero or more)
• '?' matches any single character
• '#' matches any single numeric digit (0-9)
• '@' matches any single alphabetic character (A-Z, a-z)
• [SET] matches any of the characters in the specified set
• [!SET] or [^SET] matches any character except those specified in the set (negation).

A SET can be composed of characters or ranges.  A range is in the form: 'character – character' (i.e. 0-9
or A-Z).  Although this is the simplest range allowed in the [ ] pattern, more complex inclusive ranges 
such as [0-9a-zA-Z] are allowed.  [0-9a-zA-Z] specifies that the character can be 0 through 9 or a 
through z or A through Z.  Other characters are allowed (ie. 8 bit characters) if your system supports 
them.  

In order to suppress the special syntactic significance of any of these characters  '[] * ? # @ ! ^ - \', a 
backslash ('\') must precede the special character.

10.1.1.6 Saving Format
When you are done inputting fields, click the Save button to the new layout to the database.
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10.1.2 Edit a Fixed Width Format
This section will describe how to edit a Fixed Width format.  

Click the Edit button (or double left click on the format name) to open the Fixed Width Layout 
window.

10.1.2.1 Field Definition
On the Fixed Width Layout window, the user can add, edit or delete fields of the layout format.

10.1.2.2 Remove first (header) row from data
The Remove first (header) row from data states if the first row of data should or should not be 
displayed to the end-user.

10.1.2.3 Record Separator
The Record Separator states how each row is laid out in the message data.  The default is “New Line”.
The user can change it to one of the other values in the dropdown.
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10.1.2.4 Object Names to be formatted
The Object Names to be formatted is a list of queues and topics that the format will be automatically 
applied to when the user clicks the Fixed Width Viewer in the Edit Message Window.  This parameter 
is optional.

The Object Names to be formatted can be the fully qualified queue or topic name or it can be a regular
expression pattern.

In the regular expression pattern:
• '*' matches any sequence of characters (zero or more)
• '?' matches any single character
• '#' matches any single numeric digit (0-9)
• '@' matches any single alphabetic character (A-Z, a-z)
• [SET] matches any of the characters in the specified set
• [!SET] or [^SET] matches any character except those specified in the set (negation).

A SET can be composed of characters or ranges.  A range is in the form: 'character – character' (i.e. 0-9
or A-Z).  Although this is the simplest range allowed in the [ ] pattern, more complex inclusive ranges 
such as [0-9a-zA-Z] are allowed.  [0-9a-zA-Z] specifies that the character can be 0 through 9 or a 
through z or A through Z.  Other characters are allowed (ie. 8 bit characters) if your system supports 
them.  

In order to suppress the special syntactic significance of any of these characters  '[] * ? # @ ! ^ - \', a 
backslash ('\') must precede the special character.

10.1.2.5 Saving Format
When you are done inputting fields, click the Save button to the new layout to the database.
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10.1.3 Rename a Fixed Width Format
This section will describe how to rename a Fixed Width format.  

First, click the Rename button.

Now specify a new format name then click the OK button.
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10.1.4 Delete a Fixed Width Format
This section will describe how to delete a Fixed Width format.  

First, click the Delete button.

Click the Yes button to confirm the deletion of the particular Fixed Width format.
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10.2CSV Format
This section will describe how to add, edit and delete CSV (Comma Separated Value) formats.

10.2.1 Add a CSV Format
This section will describe how to add a CSV format.  

First, click the Add button, input a unique name for this new CSV Format and click the OK button. 
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10.2.1.1 Field Definition

Next, on the CSV Layout window, the user can add fields to the layout format by clicking the Add 
button.

Input a name for the CSV column then click the OK button.

10.2.1.2 Remove first (header) row from data
The Remove first (header) row from data states if the first row of data should or should not be 
displayed to the end-user.

10.2.1.3 Field Delimiter
The Field Delimiter states how each column is separated from the next column.  The default is 
“Comma”.  The user can change it to one of the other values in the dropdown.

10.2.1.4 Record Separator
The Record Separator states how each row is laid out in the message data.  The default is “New Line”.
The user can change it to one of the other values in the dropdown.
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10.2.1.5 Object Names to be formatted
The Object Names to be formatted is a list of queues and topics that the format will be automatically 
applied to when the user clicks the Fixed Width Viewer in the Edit Message Window.  This parameter 
is optional.

The Object Names to be formatted can be the fully qualified queue or topic name or it can be a regular
expression pattern.

In the regular expression pattern:
• '*' matches any sequence of characters (zero or more)
• '?' matches any single character
• '#' matches any single numeric digit (0-9)
• '@' matches any single alphabetic character (A-Z, a-z)
• [SET] matches any of the characters in the specified set
• [!SET] or [^SET] matches any character except those specified in the set (negation).

A SET can be composed of characters or ranges.  A range is in the form: 'character – character' (i.e. 0-9
or A-Z).  Although this is the simplest range allowed in the [ ] pattern, more complex inclusive ranges 
such as [0-9a-zA-Z] are allowed.  [0-9a-zA-Z] specifies that the character can be 0 through 9 or a 
through z or A through Z.  Other characters are allowed (ie. 8 bit characters) if your system supports 
them.  

In order to suppress the special syntactic significance of any of these characters  '[] * ? # @ ! ^ - \', a 
backslash ('\') must precede the special character.

10.2.1.6 Saving Format
When you are done inputting fields, click the Save button to the new layout to the database.
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10.2.2 Edit a CSV Format
This section will describe how to edit a CSV format.  

Click the Edit button (or double left click on the format name) to open the CSV Layout window.

10.2.2.1 Field Definition

On the CSV Layout window, the user can add, edit or delete fields of the layout format.

10.2.2.2 Remove first (header) row from data
The Remove first (header) row from data states if the first row of data should or should not be 
displayed to the end-user.

10.2.2.3 Field Delimiter
The Field Delimiter states how each column is separated from the next column.  The default is 
“Comma”.  The user can change it to one of the other values in the dropdown.
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10.2.2.4 Record Separator
The Record Separator states how each row is laid out in the message data.  The default is “New Line”.
The user can change it to one of the other values in the dropdown.

10.2.2.5 Object Names to be formatted
The Object Names to be formatted is a list of queues and topics that the format will be automatically 
applied to when the user clicks the Fixed Width Viewer in the Edit Message Window.  This parameter 
is optional.

The Object Names to be formatted can be the fully qualified queue or topic name or it can be a regular
expression pattern.

In the regular expression pattern:
• '*' matches any sequence of characters (zero or more)
• '?' matches any single character
• '#' matches any single numeric digit (0-9)
• '@' matches any single alphabetic character (A-Z, a-z)
• [SET] matches any of the characters in the specified set
• [!SET] or [^SET] matches any character except those specified in the set (negation).

A SET can be composed of characters or ranges.  A range is in the form: 'character – character' (i.e. 0-9
or A-Z).  Although this is the simplest range allowed in the [ ] pattern, more complex inclusive ranges 
such as [0-9a-zA-Z] are allowed.  [0-9a-zA-Z] specifies that the character can be 0 through 9 or a 
through z or A through Z.  Other characters are allowed (ie. 8 bit characters) if your system supports 
them.  

In order to suppress the special syntactic significance of any of these characters  '[] * ? # @ ! ^ - \', a 
backslash ('\') must precede the special character.

10.2.2.6 Saving Format
When you are done inputting fields, click the Save button to the new layout to the database.
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10.2.3 Rename a CSV Format
This section will describe how to rename a CSV format.  

First, click the Rename button.

Now specify a new format name then click the OK button.
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10.2.4 Delete a CSV Format
This section will describe how to delete a CSV format.  

First, click the Delete button.

Click the Yes button to confirm the deletion of the particular CSV format.
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10.3FIX Format
This section will describe how to add, edit and delete FIX (Financial Information eXchange) formats.

10.3.1 Add a FIX Format
This section will describe how to add a FIX format.  

First, click the Add button, input a unique name for this new FIX Format and click the OK button. 
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10.3.1.1 Field Definition

Next, on the FIX Layout window, the user can add fields to the layout format by clicking the Add 
button.

Input a name for the FIX column then click the OK button.

10.3.1.2 Remove first (header) row from data
The Remove first (header) row from data states if the first row of data should or should not be 
displayed to the end-user.

10.3.1.3 Field Delimiter
The Field Delimiter states how each column is separated from the next column.  The default is “SOH 
(x’01’)”.  The user can change it to one of the other values in the dropdown.

10.3.1.4 Record Separator
The Record Separator states how each row is laid out in the message data.  The default is “New Line”.
The user can change it to one of the other values in the dropdown.
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10.3.1.5 Object Names to be formatted
The Object Names to be formatted is a list of queues and topics that the format will be automatically 
applied to when the user clicks the Fixed Width Viewer in the Edit Message Window.  This parameter 
is optional.

The Object Names to be formatted can be the fully qualified queue or topic name or it can be a regular
expression pattern.

In the regular expression pattern:
• '*' matches any sequence of characters (zero or more)
• '?' matches any single character
• '#' matches any single numeric digit (0-9)
• '@' matches any single alphabetic character (A-Z, a-z)
• [SET] matches any of the characters in the specified set
• [!SET] or [^SET] matches any character except those specified in the set (negation).

A SET can be composed of characters or ranges.  A range is in the form: 'character – character' (i.e. 0-9
or A-Z).  Although this is the simplest range allowed in the [ ] pattern, more complex inclusive ranges 
such as [0-9a-zA-Z] are allowed.  [0-9a-zA-Z] specifies that the character can be 0 through 9 or a 
through z or A through Z.  Other characters are allowed (ie. 8 bit characters) if your system supports 
them.  

In order to suppress the special syntactic significance of any of these characters  '[] * ? # @ ! ^ - \', a 
backslash ('\') must precede the special character.

10.3.1.6 Saving Format
When you are done inputting fields, click the Save button to the new layout to the database.
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10.3.2 Edit a FIX Format
This section will describe how to edit a FIX format.  

Click the Edit button (or double left click on the format name) to open the FIX Layout window.

10.3.2.1 Field Delimiter

On the FIX Layout window, the user can add, edit or delete fields of the layout format.

10.3.2.2 Remove first (header) row from data
The Remove first (header) row from data states if the first row of data should or should not be 
displayed to the end-user.

10.3.2.3 Field Delimiter
The Field Delimiter states how each column is separated from the next column.  The default is “SOH 
(x’01’)”.  The user can change it to one of the other values in the dropdown.
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10.3.2.4 Record Separator
The Record Separator states how each row is laid out in the message data.  The default is “New Line”.
The user can change it to one of the other values in the dropdown.

10.3.2.5 Object Names to be formatted
The Object Names to be formatted is a list of queues and topics that the format will be automatically 
applied to when the user clicks the Fixed Width Viewer in the Edit Message Window.  This parameter 
is optional.

The Object Names to be formatted can be the fully qualified queue or topic name or it can be a regular
expression pattern.

In the regular expression pattern:
• '*' matches any sequence of characters (zero or more)
• '?' matches any single character
• '#' matches any single numeric digit (0-9)
• '@' matches any single alphabetic character (A-Z, a-z)
• [SET] matches any of the characters in the specified set
• [!SET] or [^SET] matches any character except those specified in the set (negation).

A SET can be composed of characters or ranges.  A range is in the form: 'character – character' (i.e. 0-9
or A-Z).  Although this is the simplest range allowed in the [ ] pattern, more complex inclusive ranges 
such as [0-9a-zA-Z] are allowed.  [0-9a-zA-Z] specifies that the character can be 0 through 9 or a 
through z or A through Z.  Other characters are allowed (ie. 8 bit characters) if your system supports 
them.  

In order to suppress the special syntactic significance of any of these characters  '[] * ? # @ ! ^ - \', a 
backslash ('\') must precede the special character.

10.3.2.6 Saving Format
When you are done inputting fields, click the Save button to the new layout to the database.
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10.3.3 Rename a FIX Format
This section will describe how to rename a FIX format.  

First, click the Rename button.

Now specify a new format name then click the OK button.
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10.3.4 Delete a FIX Format
This section will describe how to delete a FIX format.  

First, click the Delete button.

Click the Yes button to confirm the deletion of the particular FIX format.
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11 Favorites
This chapter will describe how to add a favorite or organize the user's list of favorites. Favorites is 
similar to Internet Explorer's favorites but rather than adding a favorite web site, the user adds a 
favorite queue or topic and queue manager combination.

11.1Add Favorite
This section will describe how to add a favorite queue & queue manager combination to the user's 
favorite list.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select Favorite, then Add to Favorites.

There will be no change to the main panel. The action sets the queue or topic and queue manager 
combination as a favorite to the user's favorite list.
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11.2Open Favorite
This section will describe how to open a favorite queue or topic and queue manager combination.

From the main window when no queues are open, MQ Visual Edit will look like:

From the main panel of MQ Visual Edit, select Favorite, then click the favorite to be opened (i.e. 
'TEST.Q1') and the queue will be opened.
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11.3Organize Favorite
This section will describe how to organize the user's list of favorites. MQ Visual Edit's favorites are 
very similar to Internet Explorer's favorites. Basically, it gives the user a very quick way to return to a 
previously opened queue or topic and queue manager combination.

From the main window when no queues are open, MQ Visual Edit will look like:

From the main panel of MQ Visual Edit, select Favorite, then Organize Favorites.

The user can do the following actions:
• Move favorites up or down
• Delete a favorite
• Directly Open a favorite
• Save the updated favorite list when they are done.
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12 MQ Stress Testing Tools
This chapter will describes how to invoke and use the MQ Stress Testing Tools included with MQ 
Visual Edit. 

12.1Get Server
This section will describe how to invoke and use the Get Server Stress Testing tool. The Get Server 
will continuously consume messages from a queue and show statistics of its current state.  For the 
Stress Testing Servers, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Servers are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select MQ Tools, then Get Server.

This is the main panel of the Get Server. The user will need to select the queue and queue manager 
before starting the Get Server. Click the Select button to choose the queue and queue manager.

This is the standard 'Open Queue' dialog. Select the queue and queue manager then click the Open 
button.
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Once the queue and queue manager have been selected, the user can now start the Get Server by 
clicking the Start button.

While the Get Server is running, the current statistics are displayed and updated. To stop the execution 
of the Get Server click the Stop button.
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12.2Put Server
This section will describe how to invoke and use the Put Server Stress Testing tool. The Put Server 
will put messages to a queue. It can be used to stress test a 'Server Component'. The user can control 
the feed by putting a delay between the MQPUTs. The messages data can be from a simple input text 
or from a plain text file or from a Backup file (this file can contain many messages with MQMDs).  A 
Backup file can be either a SQLite Database (*.mqsdb) or a VEQ formatted file (*.veq).

For the Stress Testing Servers, you can have unlimited number of them running (up to what your box 
can support). Also, while any of the Servers are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select MQ Tools, then Put Server.

This is the main panel of the Put Server. The user will need to select the queue and queue manager 
before starting the Put Server. Click the Select button to choose the queue and queue manager.
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This is the standard 'Open Queue' dialog. Select the queue and queue manager then click the Open 
button.

Once the queue and queue manager have been selected, the user can provide more information:

• The user can select a delay between MQPUTs.
• The number of threads putting messages to the queue.
• The user can select the number of messages to be written. Note: A blank in this field means an 

UNLIMITED number of MQPUTs will be done (it will run forever).
• The user is required to select a Data Source. The message text can come from 1 of 3 sources:

1. The user can input simple text in the text box on the Put Server panel. The MQMD header 
will default to whatever the queue defaults attributes are.

2. The user can select a text file to be used as the message text. The MQMD header will 
default to whatever the queue defaults attributes are.

3. The user can select a Backup file. A Backup file can have multiple messages (including 
MQMD header) in it. Therefore, each message (with the associated MQMD header) in the 
Backup file will be written as separate messages to the queue. Note: If max messages is set 
to 100 and there are 8 messages in the Backup file then a total of 800 messages will be 
written to the output queue.

The Put Server supports token processing for both the text box and the text file options.  Note: It does 
not support token processing for an MQVE Backup file.

Supported tokens:

• ${Date} – replace the token with the current date.
• ${DateTime} – replace the token with the current date and time.
• ${FileName} – replace the token with the filename of the text file (not applicable for text box 

processing)
• ${Hostname} – replace the token with the hostname of the computer that MQ Visual Edit is 

running on
• ${LoopCounter} – replace the token with the current loop counter
• ${QMgrName} – replace the token with the queue manager name
• ${QueueName} – replace the token with the queue name
• ${Thread} – replace the token with the thread number
• ${Time} – replace the token with the current time.
• ${UserId} – replace the token with the end-user’s UserId.
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After filling in the required information, the user can start the Put Server by clicking the Start button.

While the Put Server is running, the current statistics are displayed and updated. To stop the execution 
of the Put Server click the Stop button.
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12.3SIM Client
This section will describe how to invoke and use the SIM Client Stress Testing tool. The SIM Client 
will continuously send 'request' messages and wait for a reply messages. The request message's data 
can be from a simple input text or from a plain text file or from a Backup file (this file can contain 
many messages with MQMDs).  A Backup file can be either a SQLite Database (*.mqsdb) or a VEQ 
formatted file (*.veq). 

For the Stress Testing Servers, you can have unlimited number of them running (up to what your box 
can support). Also, the SIM Client get perform the MQGET by CorrelId for a shared queue.  The out-
going message will have the Reply-To-Queue and Reply-To-QMgr fields filled in. The SIM Client will
retrieve the reply message from that particular queue. Also, the incoming message's MsgID field of the
MQMD header is copied to the outgoing message's CorrelID field of the MQMD header.

From the main panel of MQ Visual Edit, select MQ Tools, then SIM Client.

This is the main panel of the SIM Client. The user will need to select the queue and queue manager 
before starting the SIM Client. Click the Select button to choose the queue and queue manager.
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This is the standard 'Open Queue' dialog. Select the queue and queue manager then click the Open 
button.

Once the queue and queue manager have been selected, the user can provide more information:

• The user can select a delay between MQPUTs.
• The number of threads putting messages to the queue.
• The user can select the number of messages to be written. Note: A blank in this field means an 

UNLIMITED number of MQPUTs will be done (it will run forever).
• The user can use a Temporary Dynamic Queue or a Permanent Queue for reply messages. If 

the user selects a Permanent Queue then they have the option of selecting the 'Get Reply 
Message by CorrelId'. This means that the SIM Client will only retrieve reply messages that 
match the particular CorrelId.

• The user is required to select a Data Source. The message text can come from 1 of 3 sources:
◦ The user can input simple text in the text box on the SIM Client panel. The MQMD header 

will default to whatever the queue defaults attributes are.
◦ The user can select a text file to be used as the message text. The MQMD header will 

default to whatever the queue defaults attributes are.
◦ The user can select a Backup file. A Backup file can have multiple messages (including 

MQMD header) in it. Therefore, each message (with the associated MQMD header) in the 
Backup file will be written as separate messages to the output queue. Note: If there are 8 
messages in the Backup file then a total of 8 messages will be written to the output queue 
for each incoming message.

The SIM Client supports token processing for both the text box and the text file options.  Note: It does 
not support token processing for an MQVE Backup file.

Supported tokens:
• ${Date} – replace the token with the current date.
• ${DateTime} – replace the token with the current date and time.
• ${FileName} – replace the token with the filename of the text file (not applicable for text box 

processing)
• ${Hostname} – replace the token with the hostname of the computer that MQ Visual Edit is 

running on
• ${LoopCounter} – replace the token with the current loop counter
• ${QMgrName} – replace the token with the queue manager name
• ${QueueName} – replace the token with the queue name
• ${Thread} – replace the token with the thread number
• ${Time} – replace the token with the current time.
• ${UserId} – replace the token with the end-user’s UserId.
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After filling in the required information, the user can start the SIM Client by clicking the Start button.

While the SIM Client is running, the current statistics are displayed and updated. To stop the execution
of the SIM Client click the Stop button.
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12.4SIM Server
This section will describe how to invoke and use the SIM Server Stress Testing tool. The SIM Server 
will continuously consume messages and for each incoming messages, send a reply message(s). The 
reply message's data can be from a simple input text or from a plain text file or from a Backup file (this
file can contain many messages with MQMDs).  A Backup file can be either a SQLite Database 
(*.mqsdb) or a VEQ formatted file (*.veq).

The incoming message MUST have the Reply-To-Queue and Reply-To-QMgr fields filled in. The SIM
Server will use these fields to sent a reply message to. Also, the incoming message's MsgID field of the
MQMD header is copied to the outgoing message's CorrelID field of the MQMD header.

For the Stress Testing Servers, you can have unlimited number of them running (up to what your box 
can support). Also, while any of the Servers are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select MQ Tools, then SIM Server.

This is the main panel of the SIM Server. The user will need to select the queue and queue manager 
before starting the SIM Server. Click the Select button to choose the queue and queue manager.
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This is the standard 'Open Queue' dialog. Select the queue and queue manager then click the Open 
button.

Once the queue and queue manager have been selected, the user can provide more information:

• The user can choose to ignore 'Datagram' type messages or reply to them. (Note: The incoming 
message's Reply-To-Queue and Reply-To-QMgr fields of the MQMD header must be filled in.)

• The number of threads putting messages to the queue.
• The user is required to select a Data Source. The message text can come from 1 of 3 sources:

◦ The user can input simple text in the text box on the SIM Server panel. The MQMD header 
will default to whatever the queue defaults attributes are.

◦ The user can select a text file to be used as the message text. The MQMD header will 
default to whatever the queue defaults attributes are.

◦ The user can select a Backup file. A Backup file can have multiple messages (including 
MQMD header) in it. Therefore, each message (with the associated MQMD header) in the 
Backup file will be written as separate messages to the output queue. Note: If there are 8 
messages in the Backup file then a total of 8 messages will be written to the output queue 
for each incoming message.

The SIM Server supports token processing for both the text box and the text file options.  Note: It does 
not support token processing for an MQVE Backup file.

Supported tokens:

• ${Date} – replace the token with the current date.
• ${DateTime} – replace the token with the current date and time.
• ${FileName} – replace the token with the filename of the text file (not applicable for text box 

processing)
• ${Hostname} – replace the token with the hostname of the computer that MQ Visual Edit is 

running on
• ${LoopCounter} – replace the token with the current loop counter
• ${QMgrName} – replace the token with the queue manager name
• ${QueueName} – replace the token with the queue name
• ${Thread} – replace the token with the thread number
• ${Time} – replace the token with the current time.
• ${UserId} – replace the token with the end-user’s UserId.
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After filling in the required information, the user can start the SIM Server by clicking the Start button.

While the SIM Server is running, the current statistics are displayed and updated. To stop the execution
of the SIM Server click the Stop button.
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12.5Subscribe Server
This section will describe how to invoke and use the Subscribe Server Stress Testing tool. The 
Subscribe Server will continuously consume messages of a topic and show statistics of its current state.

For the Stress Testing Servers, you can have unlimited number of them running (up to what your box 
can support). Also, while any of the Servers are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select MQ Tools, then Subscribe Server.

This is the main panel of the Subscribe Server. The user will need to select the topic and queue 
manager before starting the Subscribe Server. Click the Select button to choose the topic and queue 
manager.

This is the standard 'Open Topic' dialog. Select the topic and queue manager then click the Open 
button.
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Once the topic and queue manager have been selected, the user can now start the Subscribe Server by 
clicking the Start button.

While the Subscribe Server is running, the current statistics are displayed and updated. To stop the 
execution of the Subscribe Server click the Stop button.
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12.6Publish Server
This section will describe how to invoke and use the Publish Server Stress Testing tool. The Publish 
Server will publish (put) messages to a topic. It can be used to stress test a 'Server Component'.  The 
user can control the feed by putting a delay between the MQPUTs. The messages data can be from a 
simple input text or from a plain text file or from a Backup file (this file can contain many messages 
with MQMDs).  A Backup file can be either a SQLite Database (*.mqsdb) or a VEQ formatted file 
(*.veq).

For the Stress Testing Servers, you can have unlimited number of them running (up to what your box 
can support). Also, while any of the Servers are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select MQ Tools, then Publish Server.

This is the main panel of the Publish Server. The user will need to select the topic and queue manager 
before starting the Publish Server. Click the Select button to choose the topic and queue manager.
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This is the standard 'Open Topic' dialog. Select the topic and queue manager then click the Open 
button.

Once the topic and queue manager have been selected, the user can provide more information:

• The user can select a delay between puts.
• The number of threads putting messages to the queue.
• The user can select the number of messages to be written. Note: A blank in this field means an 

UNLIMITED number of puts will be done (it will run forever).
• The user is required to select a Data Source. The message text can come from 1 of 3 sources:

1. The user can input simple text in the text box on the Publish Server panel. The Message 
Properties will default to whatever the topic defaults attributes are.

2. The user can select a text file to be used as the message text. The Message Properties 
header will default to whatever the topic defaults attributes are.

3. The user can select a Backup File. A Backup file can have multiple messages (including 
Message Properties) in it. Therefore, each message (with the associated Message 
Properties) in the Backup file will be written as separate messages to the topic. Note: If max
messages is set to 100 and there are 8 messages in the Backup file then a total of 800 
messages will be written to the topic.

The Publish Server supports token processing for both the text box and the text file options.  Note: It 
does not support token processing for an MQVE Backup file.

Supported tokens:
• ${Date} – replace the token with the current date.
• ${DateTime} – replace the token with the current date and time.
• ${FileName} – replace the token with the filename of the text file (not applicable for text box 

processing)
• ${Hostname} – replace the token with the hostname of the computer that MQ Visual Edit is 

running on
• ${LoopCounter} – replace the token with the current loop counter
• ${QMgrName} – replace the token with the queue manager name
• ${Thread} – replace the token with the thread number
• ${Time} – replace the token with the current time.
• ${TopicName} – replace the token with the selected Topic Name.
• ${TopicString} – replace the token with the selected Topic String.
• ${UserId} – replace the token with the end-user’s UserId.
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After filling in the required information, the user can start the Publish Server by clicking the Start 
button.

While the Publish Server is running, the current statistics are displayed and updated. To stop the 
execution of the Publish Server click the Stop button.
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13 MQ Analyzing Tools
This chapter will describes how to invoke and use the MQ Analyzing Tools included with MQ Visual 
Edit. 

13.1Ping Queue Manager
This section will describe how to invoke and use the Ping Queue Manager tool. The Ping Queue 
Manager will test connectivity, opening, closing of a queue and putting AND getting a series of 
messages to/from a queue of a queue manager.

Features:
• User selectable non-persistent message size
• The user can select and/or de-select the various tests that it will run.
• The time of each test series will be displayed in nanoseconds.  

Note: The elapsed time shown for message time series is the total time taken to put then get the 
message from the queue.

For the MQ Tools, you can have unlimited number of them running (up to what your box can support).
Also, while any of the MQ Tools are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select MQ Tools, then Ping Queue Manager.
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This is the main panel of the Ping Queue Manager. Click the Select button to choose the queue 
manager and options.

Select the queue manager then click the Open button.  

Next, select the non-persistent message size and the tests the end-user wants completed.  To begin the 
testing of the queue manager, click the Start button on the Ping Queue Manager window.
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As the tests are proceeding, the Ping Queue Manager window will be updated will the test results.  

Note: As you probably have read, a connection (i.e. MQCONN/MQCONNX) to a queue manager is 
a vary time consuming MQ API call.
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14 MQ Monitoring Tools
This chapter will describes how to invoke and use the MQ Monitoring Tools included with MQ Visual 
Edit. 

14.1Queue Monitor
This section will describe how to invoke and use the Queue Monitor tool. The Queue Monitor will 
continuously monitor the queues of a queue manager displaying the Queue Name, Current Queue 
Depth, Max Queue Depth, Open Input Count, Open Output Count, Get Enabled / Inhibited and Put 
Enabled / Inhibited.

Features:
• User selectable refresh rate i.e. 60 or 30 or 10 seconds
• The user can de-select the displaying of the SYSTEM queues (i.e. SYSTEM.*)
• The displayed queue attributes are: Queue Name, Current Depth, Max Queue Depth, Open 

Input Count, Open Output Count, Get and Put.
• The user can have multi windows open at the same time monitoring different queues of the 

same queue manager or monitoring of different queues of different queue managers at the same
time.

Quick visual helpers:
• If the current queue depth is between 70% to 84.99% (of max queue depth) then it is 

highlighted in 'yellow'.
• If the current queue depth is 85% or higher (of max queue depth) then it is highlighted in 'red'.
• If either the Get or Put attributes are set to Inhibited then they are highlighted in 'yellow'.

Whatever you select for the Refresh Rate will be the interval that the Depth, Input & Output fields are
measured by.

• The Depth is the current number of messages in the queue including both committed and 
uncommitted messages.

• The Input is the IPPROCS value for the queue. IPPROCS is the number of processes that have 
a queue open for input.

• The Output is the OPPROCS value for the queue. OPPROCS is the number of processes that 
have a queue open for output.

Example: If the refresh rate is 60 seconds (interval) and during the interval the Depth was 15, hence, 
15 messages were in the queue during the last 60 seconds.

For the MQ Tools, you can have unlimited number of them running (up to what your box can support).
Also, while any of the MQ Tools are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select MQ Tools, then Queue Monitor.
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This is the main panel of the Queue Monitor. Click the Start button to choose the queue manager and 
options.

This is the 'Queues To Monitor' panel, where the user selects the queue manager, refresh rate, system 
queues option and queue mask to be used during the monitoring of the queues.

• First, the user must select a queue manager which contents the queues to be monitored.
• If the queue mask is set to "*" then the user can select or de-select the system queues from 

being displayed.

The user can also combine mask filters together. Use a semi-colon (;) to separate each mask.
i.e.
ABC.*;XYZ.*;TEST.*

Hence, only queues that begin with 'ABC.', 'XYZ.' and/or 'TEST.' will be shown.

• The monitoring data can be written to a CSV (Comma Separated Value) file. On subsequent 
invocations, the user can select to append the data to the file or write the data to a new file.

Location of the Queue Monitor CSV files:
◦ On Windows: C:\Users\{UserId}\Capitalware\MQVE\QM\{QMgrName}\
◦ On Linux or Mac OS X: {home}/Capitalware/MQVE/QM/{QMgrName}/

• The user can set the rate in seconds at which the display will be refreshed.
• The user can select all queues ("*") of a queue manager to be monitored or select a partial list 

("TEST*") of the queues to be monitored.

While the Queue Monitor is running, the current real-time values are displayed and updated. To stop 
the execution of the Queue Monitor click the Stop button.
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Whatever you select for the Refresh Rate will be the interval that the Depth, Input & Output fields are
measured by.

• The Depth is the current number of messages in the queue including both committed and 
uncommitted messages.

• The Input is the IPPROCS value for the queue. IPPROCS is the number of processes that have 
a queue open for input.

• The Output is the OPPROCS value for the queue. OPPROCS is the number of processes that 
have a queue open for output.

Example: If the refresh rate is 60 seconds (interval) and during the interval the Depth was 15, hence, 
15 messages were in the queue during the last 60 seconds.

Quick visual helpers:
• If the current queue depth is between 70% to 84.99% (of max queue depth) then it is 

highlighted in 'yellow'.
• If the current queue depth is 85% or higher (of max queue depth) then it is highlighted in 'red'.
• If either the Get or Put attributes are set to Inhibited then they are highlighted in 'yellow'.
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Visualizing the Data
The user can use the "TEST.Q1.csv" file with a spreadsheet program and create a Line Chart. The 
following sample Line Chart is using just the first 2 columns of the CSV file.
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14.2Queue Statistics Monitor
This section will describe how to invoke and use the Queue Statistics Monitor tool. The Queue 
Statistics Monitor will continuously monitor the queues of a queue manager displaying the Queue 
Name, Put Rate (enqueue rate), Get Rate (dequeue rate), High Queue Depth and Max Queue Depth.

Features:
• User selectable refresh rate i.e. 60 or 30 or 10 seconds
• The user can de-select the displaying of the SYSTEM queues (i.e. SYSTEM.*)
• The displayed queue attributes are: Queue Name, Put Rate (Enqueue rate), Get Rate (Dequeue 

rate), High Queue Depth during the interval, and Max Queue Depth.
• The user can have multi windows open at the same time monitoring different queues of the 

same queue manager or monitoring of different queues of different queue managers at the same
time.

Quick visual helpers:
• If the 'High Queue Depth' is between 70% to 84.99% (of max queue depth) then it is 

highlighted in 'yellow'.
• If the 'High Queue Depth' is 85% or higher (of max queue depth) then it is highlighted in 'red'.

Whatever you select for the Refresh Rate will be the interval that the Put & Get rates are measured by.
• The Put Rate is the number of MQPUTs in the given interval.
• The Get Rate is the number of MQGETs in the given interval.

Example: If the refresh rate is 60 seconds (interval) and during the interval the Put Rate was 15, hence,
15 messages were put to the queue in the last 60 seconds.

For z/OS queue managers, you MUST enable Queue Manager Performance Events (PERFMEV) to 
use the Queue Statistics Monitor tool against a z/OS queue manager.

For the MQ Tools, you can have unlimited number of them running (up to what your box can support).
Also, while any of the MQ Tools are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select MQ Tools, then Queue Statistics Monitor.

This is the main panel of the Queue Stats Monitor. Click the Start button to choose the queue manager
and options.
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This is the 'Queues To Monitor' panel, where the user selects the queue manager, refresh rate, system 
queues option and queue mask to be used during the monitoring of the queues.

• First, the user must select a queue manager which contents the queues to be monitored.
• If the queue mask is set to "*" then the user can select or de-select the system queues from 

being displayed.

The user can also combine mask filters together. Use a semi-colon (;) to separate each mask.
i.e.
ABC.*;XYZ.*;TEST.*

Hence, only queues that begin with 'ABC.', 'XYZ.' and/or 'TEST.' will be shown.

• The monitoring data can be written to a CSV (Comma Separated Value) file. On subsequent 
invocations, the user can select to append the data to the file or write the data to a new file.

Location of the Queue Statistics Monitor CSV files:
◦ On Windows: C:\Users\{UserId}\Capitalware\MQVE\QSM\{QMgrName}\
◦ On Linux or Mac OS X: {home}/Capitalware/MQVE/QSM/{QMgrName}/

• The user can set the rate in seconds at which the display will be refreshed.
• The user can select all queues ("*") of a queue manager to be monitored or select a partial list 

("TEST*") of the queues to be monitored.

While the Queue Statistics Monitor is running, the current real-time values are displayed and updated. 
To stop the execution of the Queue Stats Monitor click the Stop button.

Whatever you select for the Refresh Rate will be the interval that the Put & Get rates are measured by.
• The Put Rate is the number of MQPUTs in the given interval.
• The Get Rate is the number of MQGETs in the given interval.
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Example: If the refresh rate is 60 seconds (interval) and during the interval the Put Rate was 15, hence,
15 messages were put to the queue in the last 60 seconds.

Quick visual helpers:
• If the 'High Queue Depth' is between 70% to 84.99% (of max queue depth) then it is 

highlighted in 'yellow'.
• If the 'High Queue Depth' is 85% or higher (of max queue depth) then it is highlighted in 'red'.
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Visualizing the Data
The user can use the "TEST.Q1.csv" file with a spreadsheet program and create a Line Chart. The 
following sample Line Chart is using just the first 4 columns of the CSV file. 
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14.3Queue Status Monitor
This section will describe how to invoke and use the Queue Status Monitor tool. The Queue Status 
Monitor will continuously monitor the queues of a queue manager displaying the Queue Name, 
Current Queue Depth, Open Input Count, Open Output Count, Last Put Date, Last Put Time, Last Get 
Date and Last Get Time.

Features:
• User selectable refresh rate i.e. 60 or 30 or 10 seconds
• The user can de-select the displaying of the SYSTEM queues (i.e. SYSTEM.*)
• The displayed queue attributes are: Queue Name, Current Queue Depth, Open Input Count, 

Open Output Count, Last Put Date, Last Put Time, Last Get Date and Last Get Time.
• The user can have multi windows open at the same time monitoring different queues of the 

same queue manager or monitoring of different queues of different queue managers at the same
time.

Whatever you select for the Refresh Rate will be the interval that the Depth, Input & Output fields are
measured by.

• The Depth is the current number of messages in the queue including both committed and 
uncommitted messages.

• The Input is the IPPROCS value for the queue. IPPROCS is the number of processes that have 
a queue open for input.

• The Output is the OPPROCS value for the queue. OPPROCS is the number of processes that 
have a queue open for output.

Example: If the refresh rate is 60 seconds (interval) and during the interval the Depth was 15, hence, 
15 messages were in the queue during the last 60 seconds.

The user MUST enable Queue Manager 'Queue Monitor' (MONQ) to use the Queue Status Monitor 
tool.

For the MQ Tools, you can have unlimited number of them running (up to what your box can support).
Also, while any of the MQ Tools are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select MQ Tools, then Queue Status Monitor.

This is the main panel of the Queue Stats Monitor. Click the Start button to choose the queue manager
and options.
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This is the 'Queues To Monitor' panel, where the user selects the queue manager, refresh rate, system 
queues option and queue mask to be used during the monitoring of the queues.

• First, the user must select a queue manager which contents the queues to be monitored.
• If the queue mask is set to "*" then the user can select or de-select the system queues from 

being displayed.

The user can also combine mask filters together. Use a semi-colon (;) to separate each mask.
i.e.
ABC.*;XYZ.*;TEST.*

Hence, only queues that begin with 'ABC.', 'XYZ.' and/or 'TEST.' will be shown.

• The monitoring data can be written to a CSV (Comma Separated Value) file. On subsequent 
invocations, the user can select to append the data to the file or write the data to a new file.

Location of the Queue Status Monitor CSV files:
◦ On Windows: C:\Users\{UserId}\Capitalware\MQVE\QSTM\{QMgrName}\
◦ On Linux or Mac OS X: {home}/Capitalware/MQVE/QSTM/{QMgrName}/

• The user can set the rate in seconds at which the display will be refreshed.
• The user can select all queues ("*") of a queue manager to be monitored or select a partial list 

("TEST*") of the queues to be monitored.

While the Queue Monitor is running, the current real-time values are displayed and updated. To stop 
the execution of the Queue Monitor click the Stop button.

Whatever you select for the Refresh Rate will be the interval that the Depth, Input & Output fields are
measured by.

• The Depth is the current number of messages in the queue including both committed and 
uncommitted messages.

• The Input is the IPPROCS value for the queue. IPPROCS is the number of processes that have 
a queue open for input.

• The Output is the OPPROCS value for the queue. OPPROCS is the number of processes that 
have a queue open for output.

Example: If the refresh rate is 60 seconds (interval) and during the interval the Depth was 15, hence, 
15 messages were in the queue during the last 60 seconds.
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14.4Visual Queue Depth
This section will describe how to invoke and use the Visual Queue Depth tool. The Visual Queue 
Depth will continuously monitor the queues of a queue manager visually displaying the queue depth.

Features:
• User selectable refresh rate i.e. 60 or 30 or 10 seconds
• The user can de-select the displaying of the SYSTEM queues (i.e. SYSTEM.*)
• The current queue depth of up to 30 queues will be charted. (Charting provided by JFreeChart)
• The user can have multi windows open at the same time monitoring different queues of the 

same queue manager or monitoring of different queues of different queue managers at the same
time.

The chart will display 60 sample points for each queue being charted. Whatever you select for the 
Refresh Rate will determine the total duration of the chart. For example, if the refresh rate is 60 
seconds then the chart will show 1 hour of data (60 1-minute samples). If the refresh rate is 30 seconds 
then the chart will show 30 minutes of data (60 30-second samples).

For the MQ Tools, you can have unlimited number of them running (up to what your box can support).
Also, while any of the MQ Tools are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select MQ Tools, then Visual Queue Depth.

This is the main panel of the Visual Queue Depth. Click the Start button to choose the queue manager 
and options.
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This is the 'Queues To Monitor' panel, where the user selects the queue manager, refresh rate, system 
queues option and queue mask to be used during the monitoring of the queues.

• First, the user must select a queue manager which contents the queues to be monitored.
• If the queue mask is set to "*" then the user can select or de-select the system queues from 

being displayed.

The user can also combine mask filters together. Use a semi-colon (;) to separate each mask.
i.e.
ABC.*;XYZ.*;TEST.*

Hence, only queues that begin with 'ABC.', 'XYZ.' and/or 'TEST.' will be shown.

• The monitoring data can be written to a CSV (Comma Separated Value) file. On subsequent 
invocations, the user can select to append the data to the file or write the data to a new file.

Location of the Visual Queue Depth CSV files:
◦ On Windows: C:\Users\{UserId}\Capitalware\MQVE\VQD\{QMgrName}\
◦ On Linux or Mac OS X: {home}/Capitalware/MQVE/VQD/{QMgrName}/

• The user can set the rate in seconds at which the display will be refreshed.
• The user can select all queues ("*") of a queue manager to be monitored or select a partial list 

("TEST*") of the queues to be monitored.
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While the Visual Queue Depth is running, the current real-time values are displayed and updated. To 
stop the execution of the Visual Queue Depth click the Stop button.
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14.5Visual Queue Statistics
This section will describe how to invoke and use the Visual Queue Statistics tool. The Visual Queue 
Statistics will continuously monitor the queues of a queue manager visually displaying the Put Rate or 
Get Rate or the average of Put and Get rates.

Features:
• User selectable refresh rate i.e. 60 or 30 or 10 seconds
• The user can de-select the displaying of the SYSTEM queues (i.e. SYSTEM.*)
• The rate is user selectable: Put, Get or average of Put and Get rates
• The current queue depth of up to 30 queues will be charted. (Charting provided by JFreeChart)
• The user can have multi windows open at the same time monitoring different queues of the 

same queue manager or monitoring of different queues of different queue managers at the same
time.

The chart will display 60 sample points for each queue being charted. Whatever you select for the 
Refresh Rate will determine the total duration of the chart. For example, if the refresh rate is 60 
seconds then the chart will show 1 hour of data (60 1-minute samples). If the refresh rate is 30 seconds 
then the chart will show 30 minutes of data (60 30-second samples).

For the MQ Tools, you can have unlimited number of them running (up to what your box can support).
Also, while any of the MQ Tools are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select MQ Tools, then Visual Queue Statistics.

This is the main panel of the Visual Queue Statistics. Click the Start button to choose the queue 
manager and options.
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This is the 'Queues To Monitor' panel, where the user selects the queue manager, refresh rate, system 
queues option and queue mask to be used during the monitoring of the queues.

• First, the user must select a queue manager which contents the queues to be monitored.
• If the queue mask is set to "*" then the user can select or de-select the system queues from 

being displayed.

The user can also combine mask filters together. Use a semi-colon (;) to separate each mask.
i.e.
ABC.*;XYZ.*;TEST.*

Hence, only queues that begin with 'ABC.', 'XYZ.' and/or 'TEST.' will be shown.

• The monitoring data can be written to a CSV (Comma Separated Value) file. On subsequent 
invocations, the user can select to append the data to the file or write the data to a new file.

Location of the Visual Queue Statistics CSV files:
◦ On Windows: C:\Users\{UserId}\Capitalware\MQVE\VQS\{QMgrName}\
◦ On Linux or Mac OS X: {home}/Capitalware/MQVE/VQS/{QMgrName}/

• The user can set the rate in seconds at which the display will be refreshed.
• The user can select all queues ("*") of a queue manager to be monitored or select a partial list 

("TEST*") of the queues to be monitored.
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While the Visual Queue Statistics is running, the current real-time values are displayed and updated. 
To stop the execution of the Visual Queue Statistics click the Stop button.
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14.6Visual Subscription Rate
This section will describe how to invoke and use the Visual Subscription Rate tool. The Visual 
Subscription Rate will continuously monitor the subscriptions of a queue manager visually displaying 
the message count of the subscriptions.

Features:
• User selectable refresh rate i.e. 60 or 30 or 10 seconds
• The message count of up to 30 subscriptions will be charted. (Charting provided by JFreeChart)
• The user can have multi windows open at the same time monitoring different queues or 

subscriptions of the same queue manager or monitoring of different queues of different queue 
managers at the same time.

The chart will display 60 sample points for each queue being charted. Whatever you select for the 
Refresh Rate will determine the total duration of the chart. For example, if the refresh rate is 60 
seconds then the chart will show 1 hour of data (60 1-minute samples). If the refresh rate is 30 seconds 
then the chart will show 30 minutes of data (60 30-second samples).

For the MQ Tools, you can have unlimited number of them running (up to what your box can support).
Also, while any of the MQ Tools are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select MQ Tools, then Visual Subscription Rate.

This is the main panel of the Visual Subscription Rate. Click the Start button to choose the queue 
manager and options.
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This is the 'Subscriptions To Monitor' panel, where the user selects the queue manager, refresh rate and
subscription mask to be used during the monitoring of the subscriptions.

• First, the user must select a queue manager which contents the queues to be monitored.
• If the queue mask is set to "*" then the user can select or de-select the system queues from 

being displayed.

The user can also combine mask filters together. Use a semi-colon (;) to separate each mask.
i.e.
ABC.*;XYZ.*;TEST.*

Hence, only subscriptiond that begin with 'ABC.', 'XYZ.' and/or 'TEST.' will be shown.

• The monitoring data can be written to a CSV (Comma Separated Value) file. On subsequent 
invocations, the user can select to append the data to the file or write the data to a new file.

Location of the Visual Subscription Rate CSV files:
◦ On Windows: C:\Users\{UserId}\Capitalware\MQVE\VSR\{QMgrName}\
◦ On Linux or Mac OS X: {home}/Capitalware/MQVE/VSR/{QMgrName}/

• The user can set the rate in seconds at which the display will be refreshed.
• The user can select all queues ("*") of a queue manager to be monitored or select a partial list 

("TEST*") of the subscriptions to be monitored.

MQ Visual Edit User's Guide                                                                                                                   Page 175



While the Visual Subscription Rate is running, the current real-time values are displayed and updated. 
To stop the execution of the Visual Subscription Rate click the Stop button.
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14.7Topic Monitor
This section will describe how to invoke and use the Topic Monitor tool. The Topic Monitor will 
continuously monitor the topics of a queue manager displaying the Topic String, Topic Name, 
Durability, Persistence, Publications, Subscriptions, Pub Current and Sub Count.

Features:
• User selectable refresh rate i.e. 60 or 30 or 10 seconds
• The user can de-select the displaying of the SYSTEM topics (i.e. SYSTEM.*)
• The displayed topic attributes are: Topic String, Topic Name, Durability, Persistence, 

Publications, Subscriptions, Pub Current and Sub Count.
• The user can have multi windows open at the same time monitoring different topics of the same

queue manager or monitoring of different topics of different queue managers at the same time.

Whatever you select for the Refresh Rate will be the interval that the Pub Count & Sub Count are 
measured by.

• The Pub Count is the Publication Count for the topic.
• The Sub Count is the Subscription Count for the topic.

Example: If the refresh rate is 60 seconds (interval) and during the interval the Pub Count was 8, 
hence, 8 publishers were publishing messages.

For the MQ Tools, you can have unlimited number of them running (up to what your box can support).
Also, while any of the MQ Tools are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select MQ Tools, then Topic Monitor.

This is the main panel of the Topic Monitor. Click the Start button to choose the queue manager and 
options.
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This is the 'Topics To Monitor' panel, where the user selects the queue manager, refresh rate, system 
topics option and topic mask to be used during the monitoring of the topics.

• First, the user must select a queue manager which contents the topics to be monitored.
• If the topic mask is set to "#" (not '*') then the user can select or de-select the system topics 

from being displayed.

The user can also combine mask filters together. Use a semi-colon (;) to separate each mask.
i.e.
ABC.#;XYZ.#;TEST.#

Hence, only topics that begin with 'ABC.', 'XYZ.' and/or 'TEST.' will be shown.

• The monitoring data can be written to a CSV (Comma Separated Value) file. On subsequent 
invocations, the user can select to append the data to the file or write the data to a new file.

Location of the Visual Queue Depth CSV files:
◦ On Windows: C:\Users\{UserId}\Capitalware\MQVE\TM\{QMgrName}\
◦ On Linux or Mac OS X: {home}/Capitalware/MQVE/TM/{QMgrName}/

• The user can set the rate in seconds at which the display will be refreshed.
• The user can select all topics ("#") of a queue manager to be monitored or select a partial list 

("TEST#") of the topics to be monitored.
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While the Topic Monitor is running, the current real-time values are displayed and updated. To stop 
the execution of the Topic Monitor click the Stop button.

Whatever you select for the Refresh Rate will be the interval that the Pub Count & Sub Count are 
measured by.

• The Pub Count is the Publication Count for the topic.
• The Sub Count is the Subscription Count for the topic.

Example: If the refresh rate is 60 seconds (interval) and during the interval the Pub Count was 2, 
hence, 3 publishers were publishing messages.
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14.8Subscription Monitor
This section will describe how to invoke and use the Subscription Monitor tool. The Subscription 
Monitor will continuously monitor the subscriptions of a queue manager displaying the Subscription 
Name, Topic String, Subscription User Durable, Type, Message Count, Last Message Date and Last 
Message Time.

Features:
• User selectable refresh rate i.e. 60 or 30 or 10 seconds
• The user can de-select the displaying of the SYSTEM subscriptions (i.e. SYSTEM.*)
• The displayed subscription attributes are: Subscription Name, Topic String, Subscription User 

Durable, Type, Message Count, Last Message Date and Last Message Time.
• The user can have multi windows open at the same time monitoring different subscriptions of 

the same queue manager or monitoring of different subscriptions of different queue managers 
at the same time.

Whatever you select for the Refresh Rate will be the interval that the Depth, Input & Output fields are
measured by.

• The Message Count is the current number of messages in the published for the subscription.
• The Last Message Date is the date when the last message was published.
• The Last Message Time is the time when the last message was published.

Example: If the refresh rate is 60 seconds (interval) and during the interval the Message Count was 15, 
hence, 15 messages, in total, have been published to the subscription.

For the MQ Tools, you can have unlimited number of them running (up to what your box can support).
Also, while any of the MQ Tools are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select MQ Tools, then Subscription Monitor.

This is the main panel of the Subscription Monitor. Click the Start button to choose the queue 
manager and options.

MQ Visual Edit User's Guide                                                                                                                   Page 180



This is the 'Subscriptions To Monitor' panel, where the user selects the queue manager, refresh rate, 
system subscriptions option and subscription mask to be used during the monitoring of the 
subscriptions.

• First, the user must select a queue manager which contents the topics to be monitored.
• If the topic mask is set to "#" (not '*') then the user can select or de-select the system topics 

from being displayed.

The user can also combine mask filters together. Use a semi-colon (;) to separate each mask.
i.e.
ABC.#;XYZ.#;TEST.#

Hence, only topics that begin with 'ABC.', 'XYZ.' and/or 'TEST.' will be shown.

• The monitoring data can be written to a CSV (Comma Separated Value) file. On subsequent 
invocations, the user can select to append the data to the file or write the data to a new file.

Location of the Visual Queue Depth CSV files:
◦ On Windows: C:\Users\{UserId}\Capitalware\MQVE\SUBM\{QMgrName}\
◦ On Linux or Mac OS X: {home}/Capitalware/MQVE/SUBM/{QMgrName}/

• The user can set the rate in seconds at which the display will be refreshed.
• The user can select all topics ("#") of a queue manager to be monitored or select a partial list 

("TEST#") of the topics to be monitored.

While the Subscription Monitor is running, the current real-time values are displayed and updated. To 
stop the execution of the Subscription Monitor click the Stop button.

Whatever you select for the Refresh Rate will be the interval that the Depth, Input & Output fields are
measured by.

• The Message Count is the current number of messages in the published for the subscription.
• The Last Message Date is the date when the last message was published.
• The Last Message Time is the time when the last message was published.

Example: If the refresh rate is 60 seconds (interval) and during the interval the Message Count was 15, 
hence, 15 messages, in total, have been published to the subscription.
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15 Other Tools
This chapter will describes how the other tools included with MQ Visual Edit.

15.1Hex Converter
This section will describe how to invoke and use the Hex Converter tool. Hex Converter tool can 
convert a hexadecimal number to its corresponding string representation and vice versa. i.e. 
0x'3132333041424344' to '1230ABCD'.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select Tools, then Hex Converter.

This is the main panel of the Hex Converter.

• The user first selects the Conversion type: "Hex to Character" or "Character to Hex"
• Input the value hex or character value into the "Input Value" field
• Click the Convert button to convert the data
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15.2Hex Editor
This section will describe how to invoke and use the Hex Editor tool. The Hex Editor is a simple 
multipurpose hex editor. The Hex Editor supports multi-file editing.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select Tools, then Hex Editor.

This is the main panel of the Hex Editor and it has 3 open files.

Supported features:
• Open / editing of multiple files
• Recent File List
• Copy, Find and Find Next
• Save, Save As and Print
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15.3Tail File
This section will describe how to invoke and use the Tail File tool. The Tail File is a simple 
multipurpose file monitoring viewer. The Tail File supports monitoring of multiple files at the same 
time.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select Tools, then Tail File.

This is the main panel of the Tail File and it has 3 open files.

Supported features:
• Opening of multiple files
• Wrap Text and Recent File List
• Copy, Find, Find Next and Print
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15.4Text Editor
This section will describe how to invoke and use the Text Editor tool. The Text Editor is a simple 
multipurpose plain-text editor. The Text Editor supports multi-file editing.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select Tools, then Text Editor.

This is the main panel of the Text Editor and it has 3 open files.

Supported features:
• Open / editing of multiple files
• Builtin XML Viewer, Wrap Text
• Recent File List
• Cut, Copy, Paste, Find and Find Next
• Save, Save As and Print
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The following shows the Text Editor's builtin XML Viewer.
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15.5Visual Difference
This section will describe how to invoke and use the Visual Difference tool. The Visual Difference is a
simple file to file comparison tool.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select Tools, then Visual Difference.

This is the main panel of the Visual Difference. To initiate the file comparison process, click File and 
then click Compare File to File

First the user needs to select the first file for the comparison.
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Next, the user needs to select the second file for the comparison.

The following shows the difference between 2 files. Differences are highlighted: Green for inserts, Red
for deletions and Blue for changes.
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15.6XML Editor
This section will describe how to invoke and use the XML Editor tool. The XML Editor is a simple 
multipurpose plain-text editor. The XML Editor supports multi-file editing.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQ Visual Edit.

From the main panel of MQ Visual Edit, select Tools, then XML Editor.

This is the main panel of the XML Editor and it has 3 open files.

Supported features:
• Open / editing of multiple files
• Recent File List
• Copy, Find and Find Next
• Save, Save As and Print
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16 Miscellaneous
This chapter will describes how the miscellaneous features of MQ Visual Edit.

16.1Preferences
This section will describe how to change / update your preferences for MQ Visual Edit.

From the main panel of MQ Visual Edit, select File then Preferences.  The user will be presented with
a popup window that has 6 panels.

General Preferences:
• Start the tools in a separate JVM - If the user wants the tools to be launched in a separate 

JVM then select this checkbox.
• User Directory - You can specify where MQ Visual Edit will store the QMgrInfo.db file. The 

QMgrInfo.db file contains all of the information necessary to connect to a queue manager.

Date and Time Formatting:
• Date Format – User selectable date format to be used when displaying a date within MQ 

Visual Edit.
• Time Format – User selectable time format to be used when displaying a time within MQ 

Visual Edit.

Font Sizes:
• Variable Width – The font size to be used for all variable width fonts in MQ Visual Edit.
• Fixed Width – The font size to be used for all fixed width fonts in MQ Visual Edit.

Networking Properties:
• Enable Proxy Server - MQ Visual Edit needs to access the internet to register the product and 

for continued use.  Enable this item if your company uses a Proxy Server.
• Proxy Host - The Proxy Server address that your company uses.
• Proxy Port - The Proxy Port number that your company uses.
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Main Window Preferences:
• Position of toolbar in the Main window - The user can select Top, Bottom, Left or Right.
• Size of each column (10-1024) - The user can set the size of the columns in the Main window. 

The user can have a column of data as small as 10 characters or as large as 1024 characters.
• Background Image - The user can select Default, User or None.  The user can change the 

default image on the main window to either a blank are (None) or select their own image to be 
used (User).  Supported image types are: PNG, GIF, JPG and JPEG.

Display Docks in Main window:
• Show 'Queue Managers' dock - The user show or not the 'Queue Managers' dock in the Main 

window.
• Show 'Status' dock - The user show or not the 'Queue Status' dock in the Main window.
• Show 'Message Descriptor' dock - The user show or not the 'Message Descriptor' dock in the 

Main window.
• Show 'Named Properties' dock - The user show or not the 'Named Properties' dock in the 

Main window.

Position of Docks in Main window:
• Position of 'Queue Managers' dock - The user can the location of the 'Queue Managers' dock 

in the Main window.
• Position of 'Status' dock - The user can the location of the 'Queue Status' dock in the Main 

window.
• Position of 'Message Descriptor' dock - The user can the location of the 'Message Descriptor' 

dock in the Main window.
• Position of 'Named Properties' dock - The user can the location of the 'Named Properties' 

dock in the Main window.

MQ Visual Edit User's Guide                                                                                                                   Page 191



Edit Window Preferences:
• Wrap text in Message Edit Window - Set the default action for 'Wrap Text' in the Message 

Edit window.
• Show line numbers in Message Edit Window - Set the default action for 'line numbers' in the 

Message Edit window.

The following are default values for the CSV Viewer when no user format is being used:
• Use first row for column names – The first row of the data will be used as the column header 

row.
• Field Delimiter – Specifies the default field delimiter to be used for CSV data.
• Record Separator – Specifies the default record separator to be used for CSV data.

The following are default values for the FIX Viewer when no user format is being used:
• Use first row for column names – The first row of the data will be used as the column header 

row.
• Field Delimiter – Specifies the default field delimiter to be used for FIX data.
• Record Separator – Specifies the default record separator to be used for FIX data.
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MQ General Preferences:
• Show message properties as Named Properties - or show them in an MQRFH2 structure

Default values for Monitoring:
• Monitor Refresh Rate in seconds - Default value used for Queue Monitor, Queue Statistics 

Monitor and Queue Status Monitor for the Refresh Rate.
• Main Window Monitor Refresh Rate in seconds - Default Refresh Rate value used for Q 

Statistics Monitor in the Main window.

Default values for Export:
• Message / File Handling - Either create a file for each message or write all message to the 

same file.
• Append Trailer Text – Enable to add trailer text to each message.
• Trailer Text – Field for adding trailer text.
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MQ Queue Preferences:
• Warn if Queue is empty - If you do not want to be told when a newly opened queue is empty, 

then deselect this checkbox.
• Automatically retrieve the entire message data when opening the 'Message Edit' window -

if it is not selected then the 'Message Edit' window will use the message data that was in the 
row of the Main window.

Default values for List Queues:
• Show System Queues - The user can set the default value for 'Show System Queues'.
• Show Temporary Queues - The user can set the default value for 'Show Temporary Queues'.
• Mask for List Queues - The user can set the default value for 'Mask for List Queues'.
• Queue Type for List Queues - The user can set the default value for 'Queue Type for List 

Queues'.
• Queue Prefix for Temporary Dynamic Queues - When the user clicks the "List Queue" 

button in the "Open Queue" window, MQ Visual Edit creates a temporary dynamic queue for 
communicating with the Queue Manager's Command Server. At some companies, security has 
been turned on so that a user cannot create queues with a CSQ prefix. Therefore, insert your 
application specific prefix that allows you to create temporary dynamic queues. e.g. HR.ABC

Default values for Open Queue:
• Convert on Get - The user can set the default value for 'Convert on Get'.
• Max. size of each message to retrieve - You can limit how much of the messages are retrieve 

from a local or remote queue manager. Note: This may be important when the messages are 
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very large. If you have a slow network then it could be minutes or even hours to retrieve all of 
the large messages of a queue.

• Max. number of messages to retrieve - If you have hundreds or thousands of messages in a 
queue, it may not be feasible to retrieve all of them. Note: If you have a slow network then it 
could be minutes or even hours to retrieve all of the large messages of a queue.

• Context - The user can set the default value for 'Context'.

Default values for Backup Queue:
• Backup File Format - The user can select either SQLite database or VEQ formatted file.
• Backup File Handling - The user can select either to create a new Backup file or Append the 

messages to an existing Backup file.

Default values for Restore Queue:
• Context - The user can set the default value for 'Context' for Restore Queue action.
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MQ Topic Preferences:

New Messages:
• Automatically scroll the table to the new message – Set the default behavior when a new 

topic is opened whether or not the view should be automatically scrolled to the newest 
message.

• Insert new messages at the top of the table - New messages will be put into the table at top.
• Insert new messages at the bottom of the table - New messages will be put into the table at 

the bottom.

Default values for List Topics:
• Show System Topics - The user can set the default value for 'Show System Topics'.
• Mask for List Topics - The user can set the default value for 'Mask for List Topics'.

Default values for Open Topic:
• Convert on Get - The user can set the default value for 'Convert on Get'.
• Max. size of each message to retrieve - You can limit how much of the messages are retrieve 

from a local or remote queue manager. Note: This may be important when the messages are 
very large. If you have a slow network then it could be minutes or even hours to retrieve all of 
the large messages of a queue.

• Context - The user can set the default value for 'Context'.
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Default values for Backup Topic:
• Backup File Format - The user can select either SQLite database or VEQ formatted file.
• Backup File Handling - The user can select either to create a new Backup file or Append the 

messages to an existing Backup file.

Default values for Restore Topic:
• Context - The user can set the default value for 'Context' for Restore Topic action.

To save your preferences, click the Ok button. To quit or cancel from the Preferences popup menu, 
click the Cancel button.  If you clicked the Ok button, then you should receive the "Preferences Saved"
popup menu.
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16.2Language
This section will describe how to switch MQ Visual Edit's Language Text to another Language Text. 
MQ Visual Edit has been designed to support Java's multi-language environment.  Currently, MQ 
Visual Edit has full language support for the following 55 languages:

 Amharic (am)
 Arabic (ar)
 Azerbaijani (az)
 Bengali (bn)
 Cebuano (ceb)
 Chinese (China) (zh)
 Chinese (Taiwan) (zh)
 Czech (cs)
 Danish (da)
 Dutch (nl)
 English (en)
 Finnish (fi)
 French (fr)
 German (de)
 Greek (el)
 Gujarati (gu)
 Hausa (ha)
 Hebrew (iw)
 Hindi (hi)

 Hungarian (hu)
 Igbo (ig)
 Indonesian (in)
 Italian (it)
 Japanese (ja)
 Javanese jv)
 Kannada (kn)
 Korean (ko)
 Malay (ms)
 Malayalam (ml)
 Marathi (mr)
 Norwegian (no)
 Panjabi (pa)
 Pashto (ps)
 Persian (fa)
 Polish (pl)
 Portuguese (pt)
 Romanian (ro)
 Russian (ru)

 Shona (sn)
 Sindhi (sd)
 Spanish (es)
 Sundanese (su)
 Swahili (sw)
 Swedish (sv)
 Tamil (ta)
 Telugu (te)
 Thai (th)
 Turkish (tr)
 Ukrainian (uk)
 Urdu (ur)
 Uzbek (uz)
 Vietnamese (vi)
 Xhosa (xh)
 Yoruba (yo)
 Zulu (zu)

From the main panel of MQ Visual Edit, select View, then Language.
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As an example, the user can select German as the Language Text to be used for MQ Visual Edit and 
then the display would look like:
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16.3Follow New Messages
This section will describe how to enable or disable the option of having the view move to the newest 
message inserted into the Topic table in the main panel.

If you have previously opened Topic test/ABC/one, the main panel may look something like:

From the main panel of MQ Visual Edit, select View, then Follow New Messages (unselect the 
option).

The main panel will not scroll when new messages are inserted, as per below:
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16.4Select All Messages
This section will describe how to select all of the messages displayed in the main panel.

If you have previously opened TEST.Q1, the main panel may look something like:

From the main panel of MQ Visual Edit, select View, then Select All.

The main panel should have all of the messages selected, as per below:
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16.5Unselect All Messages
This section will describe how to unselect all of the messages displayed in the main panel.

If you have previously opened the queue TEST.Q1 with all messages selected, then the main panel 
may look something like:

From the main panel of MQ Visual Edit, select View, then Unselect All.
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16.6Proxy UserId List
This section will describe how to create a Proxy UserId List and how to enable it with MQ Visual Edit.
A Proxy UserId is useful when the MQ Administrator does not want to define a workstation UserId on 
the server where the queue manager is located.

To create a Proxy UserId on the server where the queue manager is located, please follow the 
Operating System's instructions. Once done, the user may now create the Proxy UserId List for MQ 
visual Edit to use.

Lets assume 3 Proxy UserIds were create on the server (i.e. pu1, pu2 and pu3). Now you need to map 
the real UserId to the Proxy UserIds. If you have 6 users called: Fred, Barney, Wilma, Betty, Pebbles 
and BamBam then create a file called ProxyList.txt with the following entries:

fred = pu1
barney = pu3
wilma = pu2
betty = pu2
pebbles = pu3
bambam = pu3

Note: UserIds in the Proxy UserId list are case sensitive.

As you can see, Fred is only user that is mapped to the Proxy UserId of pu1. Wilma and Betty are 
mapped to the Proxy UserId of pu2 and Barney, Pebbles and BamBam are mapped to the Proxy UserId
of pu3.

Therefore, when the Proxy UserId List is actived in MQ Visual Edit, ALL MQ API calls will be done 
under the Proxy UserId. If a UserId is not found in the Proxy UserId List then the regular logged on 
UserId will be used. You may define a default "catch all" UserId called: DefaultProxyUserId. When 
this entry is defined in the Proxy UserId List then if a UserId is not found in the Proxy UserId List, the 
DefaultProxyUserId will be used.

Example:

red = pu1
barney = pu3
wilma = pu2
betty = pu2
pebbles = pu3
bambam = pu3
DefaultProxyUserId = pu3
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To active a Proxy UserId List, the MQ administrator sets an environment variable call JETVMPROP.

Example:
set JETVMPROP=-DProxyList=H:\test\proxylist.txt

Two important points:
1. When the Proxy UserId List is activated in MQ Visual Edit, the user can no longer change / 

update their UserId in the Queue Manager Access Profile window.
2. From an administration point of view, the users should ONLY have read access to the Proxy 

UserId List and the MQ Visual Edit's install directory.
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16.7Locking the CommProfileDB
This section will describe how to Lock the CommProfileDB file within MQ Visual Edit. The 
CommProfileDB.properties file contains all of the information necessary to connect to a queue 
manager (remote or local).

There may be times when the MQ Administrator wishes to users access to particular queue managers 
but not all of them or wishes to restrict which queue managers they can connect to.

Using MQ Visual Edit, create the CommProfileDB.properties file with all of the queue managers that 
the MQ Administrator wishes the users to access. Store the CommProfileDB.properties file on a 
network drive or a shareable directory on the server or network.

To active the locked CommProfileDB.properties, the MQ administrator sets an environment variable 
call JETVMPROP.

Example:
set JETVMPROP=-DCommProfileDB=H:\app\sample

Two important points:
1. When the lock for the CommProfileDB.properties file is activated in MQ Visual Edit, the user 

can no longer change their CommProfileDB Directory location in MQ Visual Edit's Preferences
dialog box.

2. From an administration point of view, the users should ONLY have read access to the 
CommProfileDB.properties file and also MQ Visual Edit's install directory.
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17 Appendix A – Mouse and Keyboard Actions
This section describes the buttons on MQ Visual Edit's toolbar.

17.1Toolbar

• Open Queue - Clicking the Open Queue button will display the Open Queue window.
• Refresh Queue - Clicking the Refresh Queue button will refresh the display so that it is current

with the queue on the selected queue manager.
• Close Queue - Clicking the Close Queue button will remove the currently displayed dock.
• Open Topic - Clicking the Open Topic button will display the Open Topic window.
• Close Topic - Clicking the Close Topic button will remove the currently displayed dock.
• Backup Queue - Clicking the Backup Queue button will all messages or selected messages to 

a file. The backup includes both the MQMD and the data.
• Restore Queue - Clicking the Restore Queue button will load (restore) messages from a 

backed up file. The restore will set the MQMD of the message to its original values.
• Insert Message - Clicking the Insert Message button will display the Message Edit window. 

Contents of the Message Edit window will be empty.
• Edit Message - Clicking the Edit Message button will display the selected message in the 

Message Edit window.
• Forward Message - Clicking the Forward Message button will display the Forward Message 

window, so that the selected message can be forwarded (remove from current queue and placed
on another queue). One or more messages can be forwarded.

• Delete Message - Clicking the Delete Message button will prompt the user to confirm that you 
wish to delete the selected message(s). One or more messages can be deleted.

• Cut Message - Clicking the Cut Message button will "cut" the messages from the queue and 
put them in the computer's clipboard (messages are deleted from the queue). Note: If you "cut" 
more than one message, all of the messages will be combined and placed in the clipboard as 
one message.

• Copy Message - Clicking the Copy Message button will "copy" the messages from the queue 
and into the computer's clipboard (messages remain in the queue). Note: If you "copy" more 
than one message, all of the messages will be combined and placed in the clipboard as one 
message.

• Paste Message - Clicking the Paste Message button will copy the contains of the clipboard 
(whatever that may be) to a new message and placed in the queue.

• Find - Clicking the Find button will display the Find window. The Find window allows the 
user to search for a text string that may be contained within one of the messages in the queue.

• Print Message - Clicking the Print Message button will prompt the user to confirm that you 
wish to print the selected message.

• Generate Report - Clicking the Generate Repor button will prompt the user to select the 
values (report type, report format, etc.) for the report generation.

• Preferences - Clicking the Preferences button will display the preferences popup dialog box.
• Help - Clicking the Help button will display MQ Visual Edit's Help system. The Help system 

provides various information about how and what features and functions are available in MQ 
Visual Edit.
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17.2Mousing Around in MQ Visual Edit

Left Button
• In the main window of MQ Visual Edit, while displaying messages of an opened queue, if the 

user double clicks the left mouse button, then the selected message will be display in the 
Message Edit window.

Right Button

In the main window of MQ Visual Edit, while displaying messages of an opened queue, if the user 
clicks the right mouse button, then the following popup menu will be displayed.

• Cut Message - Selecting the Cut Message menu item will "cut" the messages from the queue 
and put them in the computer's clipboard (messages are deleted from the queue). Note: If you 
"cut" more than one message, all of the messages will be combined and placed in the clipboard 
as one message.

• Copy Message - Selecting the Copy Message menu item will "copy" the messages from the 
queue and into the computer's clipboard (messages remain in the queue). Note: If you "copy" 
more than one message, all of the messages will be combined and placed in the clipboard as 
one message.

• Paste Message - Selecting the Paste Message menu item will paste the contains of the 
clipboard (whatever that may be) to a new message and place it in the queue.

• Edit Message - Selecting the Edit Message menu item will display the selected message in the 
Message Edit window.

• Edit Message in Hex - Selecting the Edit Message in Hex menu item will display the selected 
message in the Hex Message Edit window.

• Edit Message with XML Editor - Selecting the Edit Message with XML Editor menu item 
will display the selected message in the XML Editor window.

• Insert Message - Selecting the Insert Message menu item will display the Message Edit 
window. Contents of the Message Edit window will be empty.
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• Duplicate Message - Selecting the Duplicate Message menu item will replicate all the selected 
message(s) to the current queue. One or more messages can be duplicated.

• Forward Message - Selecting the Forward Message menu item will display the Forward 
Message window, so that the selected message can be forwarded (remove from current queue 
and placed on another queue). One or more messages can be forwarded.

• Delete Message - Selecting the Delete Message menu item will prompt the user to confirm that
you wish to delete the selected message(s). One or more messages can be deleted.

• Find - Selecting the Find menu item will display the Find window. The Find window allows 
the user to search for a text string that may be contained within one of the messages in the 
queue.

• Find Next - Selecting the Find Next menu item will display the Find window but the search 
will continue from the previous search position.

• Select All - Selecting the Select All menu item will select (highlight) all messages in the queue.
• Unselect All - Selecting the Unselect All menu item will de-select (un-highlight) all messages 

in the queue.
• Refresh Queue - Clicking the Refresh Queue button will refresh the display so that it is current

with the queue on the selected queue manager.
• Close Queue - Clicking the Close Queue button will remove the currently displayed tab.
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17.3Keyboard short-cuts in MQ Visual Edit
There are many short-cut (accelerator) key combinations in MQ Visual Edit.

Note: Ctrl means press and hold the Control key and then press the key after the "-" (minus sign).

Ctrl-O Will display the Open Queue window.

Ctrl-R Will refresh the contents of the queue.

Ctrl-X Will "cut" the messages from the queue and put them in the computer's clipboard 
(messages are deleted from the queue). Note: If you "cut" more than one message, all of 
the messages will be combined and placed in the clipboard as one message.

Ctrl-C Will "copy" the messages from the queue and into the computer's clipboard (messages 
remain in the queue). Note: If you "copy" more than one message, all of the messages 
will be combined and placed in the clipboard as one message.

Ctrl-V Will paste the contains of the clipboard (whatever that may be) to a new message and 
place it in the queue.

Ctrl-E Will display the selected message in the Message Edit window.

Ctrl-I Will display the Message Edit window to allow the user to insert a new message. 
Contents of the Message Edit window will be empty.

Ctrl-W Will display the Forward Message window, so that the selected message can be 
forwarded (remove from current queue and placed on another queue). One or more 
messages can be forwarded.

Ctrl-D Will prompt the user to confirm that you wish to delete the selected message(s). One or 
more messages can be deleted.

Ctrl-F Will display the Find window. The Find window allows the user to search for a text string
that may be contained within one of the messages in the queue.

Ctrl-P Will display the printer selection dialog so that the selected message can be printed.

Ctrl-G Will display the Find window but the search will continue from the previous search 
position.

Ctrl-A Will select (highlight) all messages in the queue.

Ctrl-U Will de-select (un-highlight) all messages in the queue.

F1 Will display MQ Visual Edit's Help system. The Help system provides various 
information about how and what features and functions are available in MQ Visual Edit.
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18 Appendix B – MQ Visual Edit Upgrade Procedures
To upgrade an existing installation of MQ Visual Edit, please do the following in the appropriate 
section below.

18.1Windows Upgrade
 Stop all instances of  MQ Visual Edit
 Backup any MQ Visual Edit data files in the MQ Visual Edit install directory
 Go to the Windows Control Panel and select Program and Features
 Select MQ Visual Edit and then click the Uninstall button
 Run the install program called: mqve3-setup-withjre.exe
 The installer follows the standard Windows install procedures and provides default values for 

the user.
 When the install program has completed execution, there will be a newly created folder under 

Start -> All Programs called MQ Visual Edit.
 Restore the MQ Visual Edit data files if necessary
 To run MQ Visual Edit, select the MQ Visual Edit icon from within the MQ Visual Edit folder.

18.2Linux Upgrade
 Stop all instances of  MQ Visual Edit
 Backup any MQ Visual Edit data files in the MQ Visual Edit install directory
 Next, run the installer with the following command:  

./mqve3-setup-trial-linux.bin
 The installer will prompt the user for the installation directory.  The default value will be 

'Capitalware/MQVE3/'.
 Restore the MQ Visual Edit data files if necessary
 To run MQ Visual Edit, go to the installation directory and issue the following command:

./mqve

18.3Max OS X Upgrade
 Stop all instances of  MQ Visual Edit
 Go to the Applications folder and drag the current MQ Visual Edit application to the Trash
 Double click the MQ_Visual_Edit_V3.dmg file to open it
 Follow the instructions on the opened DMG window and drag the MQ Visual Edit icon to the 

Applications folder.
 Close the DMG window and then eject the DMG
 To run MQ Visual Edit, go to the Application folder and double click on MQ Visual Edit
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19 Appendix C – Frequently Asked Questions (FAQ)

Q. What does reason code 2058 mean?

A. Generally, 2058 means that you have an invalid queue manager name or that the host does not 
have that particular queue manager. Check the spelling of the queue manager name that you inputted. 
Also, queue manager names are case sensitive (e.g. MQA1 is not the same as mqa1).

Q. What does reason code 2059 mean?

A. Generally, 2059 means that the queue manager is down. Try restarting the queue manager and 
command server on the remote box. Reason code 2059 can also occur if you inputted an incorrect port
number. Therefore, verify that the port number is correct.

Q. What does reason code 2009 mean?

A. Generally, 2009 means that the channel name is incorrect. Verify that you have inputted the 
correct server connection channel name. Also, channel names are case sensitive (e.g. JAVA.CHL is 
not the same as java.chl).

Q. What does reason code 2035 mean?

A. The reason code 2035 means that the user's UserId is not authorized to access the queue on the 
remote (or local) queue manager. Ask your IBM MQ Administrator to grant your UserId the 
necessary authority to access the queue.

Q. What does reason code 2206 mean?

A. The reason code 2206 means that z/OS shared queue is indexed by Correlation ID.  The user needs
to select Correlation ID on the Open Queue window.

Q. When I click the Test button in the Queue Manager Access Profile window, nothing happens. No 
response from MQ Visual Edit at all. 

A. This generally means that the MCA (Message Channel Agent) is timing out on a TCP/IP error. 
The TCP/IP time-out value appears to be at least 1 minute (maybe even longer).

Solutions:
• Assuming the network is stable and working, make sure that both queue manager and the 

listener are running on the box that you are attempting to connect to (or /etc/inetd and 
/etc/services have been configured correctly ).

• The time-out could be from an incorrect value for either the hostname or Port #.
◦ From a Command Prompt or Unix shell, ping the hostname - e.g. ping remotehostname or 

ping xx.xx.xx.xx
◦ Also, verify that you have inputted the same port number that the listener is using on the 

remote box.

Q. Can I use MQ Visual Edit with my mainframe (OS/390 or z/OS) queue managers?
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A. Yes. But you need to have the CAF (Client Attachment Feature) installed on z/OS (mainframe).  
On the mainframe, go to SDSF and look in the xxxxCHIN (where xxxx is the queue manager name) 
output for a message:

CSQX099I - xxxx CSQXGIP Client attachment feature available

If this message doesn't show up, then you don't have the feature installed. The CAF is a required for 
any client program (including MQ Visual Edit) to connect directly to a mainframe queue manager.

Q. Can I install MQ Visual Edit on a network drive (LAN) and run it from that location?

A. Yes. MQ Visual Edit will happily run from a network drive. Each user's preferences will be stored 
in their own "Home Directory"\Capitalware.

On Windows, the home directory is the %USERPROFILE% folder: 
i.e.
C:\users\UserID\Capitalware 

On Unix and Linux, the home directory is the user's standard logon directory 
i.e.
/export/home/UserID/Capitalware

Note: If you going to run MQ Visual Edit from a network drive and share it with other members of 
your team, please make sure you have purchased sufficient licenses of MQ Visual Edit.

Q. Can I share my queue manager connection information for MQ Visual Edit with another user or 
put it on a network drive (LAN)?

A. Yes. MQ Visual Edit stores the queue manager connection information in a SQLite database file 
called: QMgrInfo.db. By default, this file is stored in the user's "Home Directory"\Capitalware. You 
can move the QMgrInfo.db to any directory or network drive that you wish.
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20 Appendix D – Support
The support for MQ Visual Edit can be found at the following location:

Online Help Desk Ticketing System at
www.capitalware.com/phpst/

By email at:
support@capitalware.com

By regular mail at:

Capitalware Inc.
Attn: MQ Visual Edit Support
Unit 11, 1673 Richmond Street, PMB524
London, Ontario  Canada
N6G 2N3
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21 Appendix E – Summary of Changes

 MQ Visual Edit v3.2.0
o Added support for importing COBOL Copybook into the 'Fixed Width' configuration 

window for User Format.
o Added 'Number of threads' for the following MQ Tools:  Put Server, SIM Server, SIM 

Client & Publish Server.
o Added 12 replaceable tokens for the following MQ Tools:  Put Server, SIM Server, SIM

Client & Publish Server.
o Added right-click menu for selecting the replaceable tokens on the text box for: Put 

Server, SIM Server, SIM Client & Publish Server.
o Added 'Show Temporary Queues' checkbox on the Open Queue and MQ Monitoring 

Tools' Open Queue dialog
o Added the ability to sort the columns by clicking on the column header of List Of 

Queues and List Of Topics popup windows.
o Added support for user defined date and time fields in the Preferences window.
o Added the product version number to the Registration window.
o Added code to convert Event messages as they are retrieved from the queue rather when

the user opens the Message Edit window.
o For CSV, FIX and Fixed Width Viewers, added the ability to click on the column 

header to sort the data by that column.
o For CSV, FIX and Fixed Width layout manager, added 'Type for Table Sorting' column.

It tells MQ Visual Edit how to sort the data in a particular column (i.e. String, Integer, 
Double, etc.).

o Improved the handling of right-click popup menu on the main window, List of Queues 
and List of Topics windows

o Enhanced the logging to include all GUI classes.
o Fixed issue with preferences being removed when the language is changed.
o Fixed issue with user selected language not being saved as a Preference.
o Fixed an issue with the Choose Columns for MQMD.
o Fixed an issue with the dock width setting not being removed when the Reset View was

selected (under the View menu item).
o Fixed an issue with the SIM Client missing the Browse button for text file.
o Fixed an issue with handling PCF MQCFT_XR_SUMMARY messages from z/OS 

queue managers.
o Fixed an issue with renaming a Group (on main window).

 MQ Visual Edit v3.1.0
o Added a new MQ tool called Ping Queue Manager.  It allows the user to test the 

response time of a queue manager putting AND getting a series of messages.
o Added an AMS Keystore setting page on the Queue Manager Access Profile window to 

allow the user to select the AMS Keystore to be used.
o Added the ability the set both the variable width and fixed width font sizes on the 

General panel of the Preferences window.
o Added a setting On the Preferences's 'Main Window' panel to allow the user to change 

the default background or to disable it.
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o Added code to only retrieve the hostname and canonical hostname values once (on 
program startup) and set it as a system properties.

o Fixed a bug in Message Edit window for auto column header creation for CSV and FIX 
data that have more than 700 columns.

o Fixed an issue with getting entire message when 'Automatically retrieve the entire 
message data when opening the 'Message Edit' window' is selected in options.

o Corrected the fixed width font on macOS and Linux
o Fixed an issue with the import parsers for MQ Explorer, MO71, and CCDT.  Now it 

correctly handles MQ MI or MQ HA hostnames.
o Added code to better handle missing channel exit and/or incorrect path to channel exit.
o Fixed an issue so that the correct queue manager profile is selected after either a rename

or move.
o Added support for escaped characters (i.e. \n, \r, etc. ) on the Import File window when 

Delimited File is selected
o Fixed an issue with Clear Queue not recognizing alias or cluster queue when clearing 

queue.
o Fixed an issue with 'List Queues' from right click on main window not correctly setting 

queue type.
o Fixed an issue with MQ Tools drop-down when the users is running the trial-only 

(MQVE only).
o Added code to better handle messages with CCSID of 1200 and 1201.
o Added support for MQMDE structure on the Message Edit window.
o Fixed an issue with data conversion when 'Convert On Get' is selected and the EBCDIC

message's MQMD Format field is blank.
o Fixed an issue with Generate Report not properly creating the character display portion 

of the HEX output in the PDF.
o Enhanced the Mask field processing for the List of Queues window to handle more 

complex masks.
o Added a popup window to display the mask to be used for a Refresh action on the List 

Of Queues window.  The user can update/change it and then click ok (or press enter) to 
refresh the queue list.

o Updated the list of SSL/TLS CipherSpec/CipherSuite to be aligned with MQ v9.2.

 MQ Visual Edit v3.0.0
o Added a new MQ tool called Visual Queue Statistics.  It allows the user to visually 

display the queue statistic values in a chart.
o Added a new MQ tool called Visual Subscription Rate.  It allows the user to visually 

display the subscription's message count in a chart.
o Added a dialog window to retrieve the context value for 'Put Options' for the Restore 

Queue/Topic feature.
o Added Context for 'Put Options' on the Open Queue/Topic window for Put Server, SIM 

Client, SIM Server and Publish Server.
o Added a new viewer on the Message Edit window called: Fixed Width Viewer.  

Clicking it will parse the message data into a spreadsheet display.
o Added a new viewer on the Message Edit window called: CSV Viewer.  Clicking it will

parse the message data into a spreadsheet display.
o Added a new viewer on the Message Edit window called: FIX (Financial Information 

eXchange) Viewer.  Clicking it will parse the message data into a spreadsheet display.
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o Added a wizard so that the user can quickly create and save Fixed Width format 
structure, CSV column names and FIX column names.

o Added a new options on the Preferences' Edit Window called: 'For CSV Viewer, use 
first row for column name', drop selector for field delimiter and a drop selector for 
record separator.

o Added a new options on the Preferences' Edit Window called: 'For FIX Viewer, use first
row for column name' and drop selector for delimiter, drop selector for field delimiter 
and a drop selector for record separator.

o Added the ability to associate a time zone with a queue manager.  Hence, the message's 
date and time will be in the specified time zone.

o Changed Queue Manager Access Profile, Group and Favorites information to be stored 
in a SQLite database

o Added code to automatically migrate CommProfileDB, CommProfileGroupDB and 
FavoritesDB property files to a SQLite database.

o For a fresh install of MQ Visual Edit (Windows and Linux only), added code to 
automatically collect local queue manager information and display it to the user for 
importing.

o Added the ability to import queue manager settings from MQ Explorer.
o Added the ability to import queue manager settings from MO71.
o Added the ability to import queue manager settings from MQ Visual Edit V1/V2 

property file.
o Added the ability to import queue manager settings from a CCDT file.
o Added the ability to import local queue managers.
o Fixed an issue with resetting the view correctly and also when changing the language.
o Added launching a web browser from the Registration window for the user to register 

the license key.
o New location for SQLite database and the MQVE logfile.  They will now be stored in 

{home_directory}\Capitalware\ directory.  i.e. For Windows: C:\Users\{UserId}\
Capitalware\ and for Linux/macOS: /home/{UserId}/Capitalware/

o The MQ Visual Edit logfile will now be called: MQVE.log  (rather than 
MQVE_error.log).

o Moved the MQ Server and Monitor tools to their own menu dropdown called: MQ 
Tools

o Enhanced the error message regarding an expired license key
o Updated code to better handle "https" call to capitalware.com for registration
o Updated code to set JVM UserId because MQ client library uses it when 

USE_MQCSP_AUTHENTICATION_PROPERTY is set to true
o Increased the size of the buttons on the windows, so people with Microsoft Surface 

tablets will find it easier to click buttons with their fingers.
o Added icons to all of the buttons on the windows. The icons for the buttons match the 

icons for the menu items.  Hence, it makes for a better and more consistent look and 
feel.

o Fixed an issue with parsing PCF messages and displaying them.
o Fixed an issue with Queue Monitor tool and connecting to a z/OS queue manager.
o Fixed a bug on Message Edit window where Wrap Text menu item was not honoring 

user Preferences.
o Fixed a bug on Message Edit window where Replace menu item was not being 

enabled/disabled correctly.
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o Switched from Apache Xerces to Java's builtin XML parser.
o Updated docs (English only)

 MQ Visual Edit v2.4.0
o Updated Backup and BackupTopic functions to support writing the messages to a 

SQLite database.
o Updated Restore and RestoreTopic functions to support reading the messages from a 

SQLite database.
o Updated PutServer, SIMClient, SIMServer and PublishServer functions to support 

reading the messages from a SQLite database.
o Changed the web call to capitalware.com server for license registration from http to 

https.
o Fixed an issue with Named Properties object being null on Message Edit window
o Fixed an issue with Backup Queue, Backup Topic and message conversion
o Fixed an issue with Export Message and message conversion
o Fixed an issue with MQMD on the Message Edit window
o Fixed an issue with Named Properties when creating a JMS message
o Added extra code to handle issues with opening and/or writing to the logfile when the 

OS is using file redirection.
o Fixed an issue with the message being deselected when the message is saved in the 

Message Edit window
o For z/OS queue managers, added code to allow the user to select the indexing of the 

z/OS shared queue.
o Added UserId compatibility mode on the UserId panel of the Queue Manager Access 

Profile window. Connectivity will use MQCSP structure by default.

 MQ Visual Edit v2.3.0
o Fixed issue with using both Topic Name and Topic String
o Fixed issue on Subscribe/Publish Server Open Topic window to allow only Topic Name
o Added code to update screen title with either (1) days remaining in subscription or (2) 

days remaining in trial.
o Added code to show resolved topic object for dock title and application title.
o Fixed an issue with Generate Report and low values being converted to spaces.
o Fixed an issue with File -> Add Queue Manager Access Profile feature adding the 

queue manager to the wrong group.
o Added code on Registration window to remove a single quote (') from the name field 

when retrieving the Access Code.
o Added code to make sure all MQExceptions are caught.
o Added Clear button on Registration window to allow the user to remove name, email 

address, license key and access code from the saved settings.
o Fixed an issue where the Refresh Queue option caused another thread (to inquire on the 

queue) to be launched for the Status dock.
o Rewrote the internals of MQ Visual Edit to better handle data conversion between 

codepages.
o Fixed an issue with writing data to CSV file for Subscription Monitor.
o MQ Visual Edit is now built as a 64-bit executable for Linux, macOS and Windows.
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 MQ Visual Edit v2.2.0
o Added Prompt for Password on the UserId panel of the Queue Manager Access Profile 

window
o Added a JSON Viewer for JSON data on the Message Edit window
o Added back 'Open Read Only' feature on the Open Queue Window
o Added 'Open Read Only' feature on the Open Topic Window
o Added checks for Proxy Host and Port when Proxy Server is enabled
o Added 'Automatically scroll the table to the new message' to the 'MQ Topic' window 

panel of the Preferences popup window
o Added the 'Follow New Message' menu item under View menu item (it toggles on/off 

the auto scrolling for Topic messages)
o Added Topic Name to the Open Topic window.
o Added Cut and Delete Message to the main window for Topic Messages (Note: 

Messages are only removed from the table and not from the topic).
o Added 2 new Topic Stress Testing Tools: Subscribe Server and Publish Server.
o Added support on 'Forward Message' feature to remove MQRFH2 wrapped MQDEAD 

messages if 'Remove Dead Letter Header' is specified.
o Added support for more internal MQ headers: MQDH, MQRMH, MQTM and MQWIH
o Added support for delimiters to parse file(s) for 'Import File' feature.
o Added support for 30 new languages: Amharic, Arabic, Azerbaijani, Bengali, Cebuano, 

Gujarati, Hausa, Hebrew, Igbo, Javanese, Kannada, Malay, Malayalam, Mandarin, 
Marathi, Pashto, Persian, Shona, Sindhi, Sundanese, Swahili, Tamil, Telugu, Turkish, 
Ukrainian, Urdu, Uzbek, Xhosa, Yoruba & Zulu

o Changed the location of the 'MQVE_error.log' file to be the same directory as the 
'CommProfileDB.properties' file.

o Fixed an issue with 'Forward Message' feature
o Fixed an issue when Reset View was invoked and the subscriptions were not stopped.
o Fixed an issue with not being able to select a message when it does not have payload 

(message data)
o Fixed an issue with MQMD columns not showing when a message does not have 

payload (message data)
o Fixed an issue with PutApplType being shown when MQMD columns are being 

displayed.
o Fixed an issue with MQMD columns not honoring column alignment.
o Fixed an issue with the Cut Message on the main screen.
o Fixed an issue with PutDate & PutTime on the MQXQH panel.
o Fixed an issue with acquiring the 'i'th Access Code.
o Fixed an issue with the Button Bar on Mac OS X.
o Fixed button selection coloring on Mac OS X.
o Fixed an issue with coloring the main table when the topic string contains either '#' or 

'+'.
o Fixed an issue with sort columns on List of Topics window.
o Made sure Favorites and MQ Monitoring Tools store the settings/information in the 

'User Directory'.
o Switched to JVM v1.8

MQ Visual Edit User's Guide                                                                                                                   Page 218



 MQ Visual Edit v2.1.0
o Added support for 18 new languages
o Added Send and Receive Exits on the Exits panel of the Queue Manager Access Profile 

window
o Added colored topic messages on main window when a topic was opened using a 

wildcard
o Added the 'Reset View' feature (under the View menu item) to reset the framework to 

its default values
o Added back the 'Get All Data' button on the Message Edit window.  To enable this 

feature, the 'Automatically retrieve entire message' checkbox on the 'MQ Queue' panel 
of the Preferences window must be de-selected.

o Added more checks/verifications around the registration, so that users input the correct 
information

o Fixed a variety of bugs related to the framework.
o Fixed several bugs related to internal message handling

 MQ Visual Edit v2.0.0
o Initial release.
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22 Appendix F1 - License Agreement - Unregistered

LIMITED WARRANTY

THE PROGRAM IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL 
THE AUTHOR OR AUTHORS BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, ARISING OUT OF THE USE OF THE 
PROGRAM, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE, UNDERSTAND IT AND 
AGREE TO BE BOUND BY ITS TERMS AS THE COMPLETE AND EXCLUSIVE STATEMENT 
OF THE AGREEMENT BETWEEN US, SUPERSEDING ANY PROPOSAL OR PRIOR 
AGREEMENT, ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN US 
RELATING TO THE SUBJECT MATTER OF THIS LICENSE.

MQ Visual Edit is a shareware program and is provided at no charge to the user for evaluation. The 
purpose of shareware software is to provide personal computer users with quality software on a "try 
before you buy" basis, however payment is still required for continued use of the product.

If you find this program useful and continue to use it after a the trial period, you must make a 
registration payment (see the registration instructions for details). This registration fee will license one 
user to use one copy of MQ Visual Edit on any one computer at any one time. All users will receive a 
copy of the latest release when they register, or it will be made available for downloading, and free 
technical support.

Commercial users must register and pay for their copies within 30 days of first use or their license is 
withdrawn.

Anyone distributing this product for any kind of remuneration must first contact Capitalware Inc. for 
authorization.

You may distribute this software to friends and colleagues but you must include all files in the original 
distribution. Please encourage them to register their copy if they find that they make use of it.
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23 Appendix F2 – License Agreement - Registered
This is a legal agreement between you (either an individual or an entity) and Capitalware Inc. By 
opening the sealed software packages (if appropriate) and/or by using the SOFTWARE, you agree to 
be bound by the terms of this Agreement. If you do not agree to the terms of this Agreement, promptly 
return the disk package and accompanying items for a full refund.
SOFTWARE LICENSE

1. GRANT OF LICENSE. This License Agreement (License) permits you to use one copy of the 
software product identified above, which may include user documentation provided in on-line or 
electronic form (SOFTWARE). The SOFTWARE is licensed as a single product, to an individual user,
or group of users for Enterprise License. This Agreement requires that each user of the SOFTWARE 
be Licensed, either individually, or as part of a group. An Enterprise License provides for an unlimited 
number of users to use this SOFTWARE at any time at the specific company. The individual license 
does not provide for concurrent user Licensing. Each user of this SOFTWARE must be covered either 
individually, or as part of a group Enterprise License. The SOFTWARE is in use on a computer when 
it is loaded into the temporary memory (i.e. RAM) or installed into the permanent memory (e.g. hard 
disk) of that computer. This software may be installed on a network provided that appropriate 
restrictions are in place limiting the use to registered users only.  The license, whether individual or 
enterprise, is for a 1-year subscription which includes the latest release of the SOFTWARE and 
support.

2. COPYRIGHT. The SOFTWARE is owned by Capitalware Inc. and is protected by United States Of 
America and Canada copyright laws and international treaty provisions. You may not copy the printed 
materials accompanying the SOFTWARE (if any), nor print copies of any user documentation 
provided in on-line or electronic form. You must not redistribute the registration codes provided, either
on paper, electronically, or as stored in the files MQVE.REG, MQVE.PROPERTIES, MQVE.INI or 
any other form.

3. OTHER RESTRICTIONS. The registration notification provided, showing your authorization code 
and this License is your proof of license to exercise the rights granted herein and must be retained by 
you. You may not rent or lease the SOFTWARE, but you may transfer your rights under this License 
on a permanent basis, provided you transfer this License, the SOFTWARE and all accompanying 
printed materials, retain no copies, and the recipient agrees to the terms of this License. You may not 
reverse engineer, decompile, or disassemble the SOFTWARE, except to the extent the foregoing 
restriction is expressly prohibited by applicable law.

LIMITED WARRANTY

LIMITED WARRANTY. Capitalware Inc. warrants that the SOFTWARE will perform substantially 
in accordance with the accompanying printed material (if any) and on-line documentation for a period 
of 365 days from the date of receipt.

CUSTOMER REMEDIES. Capitalware Inc. entire liability and your exclusive remedy shall be, at 
Capitalware Inc. option, either (a) return of the price paid or (b) repair or replacement of the 
SOFTWARE that does not meet this Limited Warranty and that is returned to Capitalware Inc. with a 
copy of your receipt. This Limited Warranty is void if failure of the SOFTWARE has resulted from 
accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted for the remainder 
of the original warranty period or thirty (30) days, whichever is longer.
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NO OTHER WARRANTIES. To the maximum extent permitted by applicable law, Capitalware Inc. 
disclaims all other warranties, either express or implied, including but not limited to implied warranties
of merchantability and fitness for a particular purpose, with respect to the SOFTWARE and any 
accompanying written materials.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. To the maximum extent permitted by 
applicable law, in no event shall Capitalware Inc. be liable for any damages whatsoever (including, 
without limitation, damages for loss of business profits, business interruption, loss of business 
information, or other pecuniary loss) arising out of the use or inability to use the SOFTWARE, even if 
Capitalware Inc. has been advised of the possibility of such damages.
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24 Appendix G – Notices

Trademarks:

AIX, IBM, MQSeries, OS/2 Warp, OS/400, iSeries, MVS, OS/390, WebSphere, WebSphere MQ and 
z/OS are trademarks of International Business Machines Corporation.

HP-UX is a trademark of Hewlett-Packard Company.

Intel is a registered trademark of Intel Corporation.

Java, J2SE, J2EE, Sun and Solaris are trademarks of Sun Microsystems Inc.

Linux is a trademark of Linus Torvalds.

Mac OS X is a trademark of Apple Computer Inc.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation.

UNIX is a registered trademark of the Open Group.

WebLogic is a trademark of BEA Systems Inc.
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